Canon  Windows |

Image Viewing, Organizing and Editing Software

ZoomBrowser EX
Ver. 6.2
Instruction Manual

In this manual, ZB is used for ZoomBrowser EX.
In this manual, the windows used in the examples are from Windows XP.

Click on the icons below on the bottom right of the screen to switch
between pages.

@ . GO to next page @ . GO to previous page
@ . Return to a page you had previously displayed

Click on the chapter headings on the right side of the screen to switch to
the contents page of each chapter.
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READ CAREFULLY BEFORE USING!

CANON SOFTWARE LICENSE AGREEMENT

IMPORTANT - READ THIS AGREEMENT BEFORE USING THE SOFTWARE ON THE CD-ROM
IN THIS BOX. BY USING THE SOFTWARE, YOU AGREE TO BE BOUND BY THE TERMS OF
THIS AGREEMENT.

This is a license agreement (the [Agreement]) between you and Canon Inc. ([Canon]).

IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT, DO NOT
USE THE SOFTWARE PROGRAM ON THE CD-ROM AND THE USER MANUAL IN THIS BOX
(COLLECTIVELY, THE [SOFTWARE]) AND RETURN THE SOFTWARE WITHIN 30 DAYS FROM
THE DATE OF PURCHASE TO YOUR POINT OF PURCHASE FOR A REFUND.

In consideration of the right to use the SOFTWARE, you agree to abide by the terms and conditions
of this Agreement.

1. LICENSE: Canon grants you the non-exclusive right to use the SOFTWARE only on a single
computer. You may physically transfer the SOFTWARE from one computer to another provided
that the SOFTWARE is used on only one computer at a time. You shall not install or use the
SOFTWARE on a network, multiple CPU, multiple site arrangement, or any other hardware
configuration where the SOFTWARE is accessible to more than one CPU or to more than one
user.

YOU SHALL NOT ASSIGN, SUBLICENSE, RENT, LEASE, LOAN, CONVEY OR OTHERWISE USE,
TRANSFER, COPY, TRANSLATE, CONVERT TO ANOTHER PROGRAMMING LANGUAGE,
ALTER, MODIFY, DECOMPILE OR DISASSEMBLE THE SOFTWARE, IN WHOLE OR IN PART,
EXCEPT AS EXPRESSLY PROVIDED IN THIS AGREEMENT.

2. BACK-UP COPY: You may make one copy of the SOFTWARE solely for back-up purposes, or
copy the SOFTWARE onto the permanent storage device (e.g. a hard disk) of your computer
and retain the original for back-up purposes. Any other copying of the SOFTWARE is a violation
of this Agreement. You must reproduce and include the copyright notice on the back-up copy.

3. SUPPORT AND UPDATES: Canon is not responsible for providing maintenance or support for
use of the SOFTWARE. No updates, fixes or support will be made available for the
SOFTWARE.

4. LIMITED WARRANTY AND LIMITATION OF LIABILITY: It is your responsibility to choose,
maintain and match the hardware and software components of your computer system. Thus
Canon does not guarantee uninterrupted service or correction of errors or that the functions or
performance of the SOFTWARE will meet your requirements. THE SOFTWARE IS LICENSED
ON AN [AS IS] BASIS AND WITHOUT WARRANTY OF ANY KIND. The CD-ROM storing the
SOFTWARE is warranted only against defective material under normal use for a period of ninety
(90) days after purchase from an authorized Canon dealer as evidenced by your sales receipt.
Your sole remedy for a defective CD-ROM shall be replacement of the same without charge
when returned by you at your expense to your point of purchase and proven to be defective
upon inspection. The replacement CD-ROM will be warranted for the remainder of the original
ninety (90) day warranty period of the defective CD-ROM. The limited warranty does not apply if
the failure of the CD-ROM resulted from accident, abuse or misapplication of the SOFTWARE
and shall not extend to anyone other than the original user of the SOFTWARE.

EXCEPT AS SPECIFICALLY SET FORTH IN THIS PARAGRAPH 4, CANON, CANON'’S
SUBSIDIARIES, DISTRIBUTORS AND DEALERS DISCLAIM ALL WARRANTIES, EXPRESS OR
IMPLIED, INCLUDING ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE, WITH RESPECT TO THE SOFTWARE.

NEITHER CANON NOR ANY OF CANON'S SUBSIDIARIES, DISTRIBUTORS OR DEALERS IS
LIABLE FOR ANY DAMAGES HOWSOEVER CAUSED, INCLUDING WITHOUT LIMITATION,
DIRECT, CONSEQUENTIAL OR INCIDENTAL LOSS OR DAMAGE INCLUDING LOSS OF
PROFITS, EXPENSE OR INCONVENIENCE HOWSOEVER CAUSED OR ARISING OUT OF THE
SOFTWARE OR THE USE THEREOF.

NEITHER CANON, NOR ANY OF CANON'S SUBSIDIARIES, DISTRIBUTORS OR DEALERS
SHALL HAVE ANY OBLIGATION TO INDEMNIFY YOU AGAINST ANY CLAIM OR SUIT
BROUGHT BY A THIRD PARTY ALLEGING THAT THE SOFTWARE OR THE USE THEREOF
INFRINGES ANY INTELLECTUAL PROPERTY OF SUCH THIRD PARTY.

5. TERM: This Agreement is effective upon your using the SOFTWARE and remains in effect until
expiration of all copyright interests in the SOFTWARE unless earlier terminated. You may
terminate this Agreement by destroying the SOFTWARE. This Agreement will also terminate
without notice to you if you fail to comply with any of the terms of this Agreement and you must
then promptly return the SOFTWARE. In addition, Canon may enforce its other legal rights.

6. U.S. GOVERNMENT RESTRICTED RIGHTS NOTICE: The SOFTWARE is provided with
restricted rights. Use, duplication or disclosure is subject to restrictions as set forth in either
subparagraph (c) (1) (i) of the Rights in Technical Data and Computer software clause at
DFARs 252.227-7013 or subparagraph (c) (1) and (2) of the Commercial Computer Software
Restricted Rights Clause at FAR 52.227-19, as applicable.

7. SEVERABILITY: In the event that any provision of this Agreement is declared or found to be
illegal by any court or tribunal of competent jurisdiction, such provision shall be null and void
with respect to the jurisdiction of that court or tribunal and all the remaining provisions of this
Agreement shall remain in full force and effect.

8. CONTROLLING LAW: The terms of this Agreement as it relates to purchases of the Software in
the United States of America shall be governed and construed in all respects in accordance with
the laws and regulations of the State of New York, without reference to choice of law principles.
The terms of this Agreement as it relates to purchases of the Software in Canada shall be
governed by the laws of the province of Ontario.

9. OWNERSHIP: All rights, including but not limited to copyrights and trade secret rights, to the
SOFTWARE belong to Canon, its affiliated corporations and third party licensors. Your use of
the SOFTWARE is subject to the United States, Canada and other applicable copyright and
trademark laws and nothing in this Agreement constitutes a waiver of the rights of Canon, its
affiliated corporations and third party licensors under such laws.

Nothing contained in Paragraph 1 shall be construed to give Canon any ownership rights in any
images, graphics or textual material that you save in connection with the Software.

10.ACKNOWLEDGEMENT: BY USING THE SOFTWARE, YOU ACKNOWLEDGE THAT YOU
HAVE READ THIS AGREEMENT, UNDERSTOOD IT, AND AGREE TO BE BOUND BY ITS
TERMS AND CONDITIONS. YOU ALSO AGREE THAT THIS AGREEMENT IS THE
COMPLETE AND EXCLUSIVE STATEMENT OF AGREEMENT BETWEEN YOU AND CANON
CONCERNING THE SUBJECT MATTER HEREOF AND SUPERSEDES ALL PROPOSALS
OR PRIOR AGREEMENTS, VERBAL OR WRITTEN, AND ANY OTHER COMMUNICATIONS
BETWEEN THE PARTIES RELATING TO THE SUBJECT MATTER HEREOF. NO
AMENDMENT TO THIS AGREEMENT SHALL BE EFFECTIVE UNLESS SIGNED BY A DULY
AUTHORIZED OFFICER OF CANON.
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Introduction

Main Features of ZB

Download images to your computer
Check images

Print images

Organize images

Edit images
Adjust images
Trim images
Insert text
Correct red-eye

Utilize images
Attach an image to an e-mail
Create wallpaper or a screen saver

Convert images
Change image size and type

Symbols Used - a

: Selection procedure for menus that appear on the computer
screen
[ ]1:Names of items and menus, buttons, windows, etc. that appear on
the computer screen
: Camera switch name or icon, or a keyboard key name
: Reference page (jump to page by clicking)

A/
~ N

< >
p.**
"2 :Help @< : Tip

: Important information |§| : Helpful information

Makeup of Each Chapter

Chapter 1 Basic Operation
Starting up and exiting ZB
Downloading images to your computer
Checking images
Printing images

Chapter 2 Advanced Operation
Efficient checking of images
Organizing images
Editing images
@ Utilizing images
® Index printing

Chapter 3 High-Level Functions

©® Checking images with high-level functions
» Organizing images with high-level functions
@ Advanced image editing

© Printing with other software

Chapter 4 Preferences
Settings for all functions

Reference
Solving problems
Uninstalling ZB
System requirements
Supported images
Lists of primary window functions
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1 Basic Operation

Starting UP ZB......cooii 7
Downloading an Image to Your Computer ................ 7
Downloading Images Using Your Card Reader............ 9
Viewing an Image .........oooovviieiiiiiiiii e 11
View Images as Thumbnails in the Main Window ...... 11
Enlarging a Selected Folder .................ccccovvvvnen. 12
Changing the Display Magnification ....................... 13
Enlarging and Viewing Images One ata Time............ 13
Displaying an Image Across the Whole Window (Full
VIeW DISpPlay) .....coovvuviiiiieeeiieee e 14
Printing an Image .........coouvviiiiinieeeeeeeeeeeeiii e 15
Printing One Image on One Sheet of Paper............... 15
Printing an Image Using Easy-PhotoPrint EX ............ 16
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Starting up ZB

Double-click the desktop icon.

Fhoto
hal

Double-click

=» ZB starts up and the main window appears.

v

Main window

¢ B - CAlocemments and e

Tasks Q| 5 2] e zow [ s
B dccpion b Cormmn St Toon Mode | Soxibsds | Purview bodks

[ veroma My Ptaes - k% T e -

- Exon

(=R

Linst Becepie It (=]

Farvostn Foidery| A1 Foiders

3]

& pestn
3 Saarch Resubs

(D) The [CANON iIMAGE GATEWAY] button may not be displayed
depending on the area you are in.

Downloading an Image to Your Computer

Connect the camera and computer with the cable provided and
download the images saved on the memory card inserted in the camera.
For downloading images, start up the camera software “EOS Utility”
from ZB and use.

G

Introduction

Table of
Contents

1 Select the save destination for the images.

Lazt Acquired Images e

Images acquired from your camera
can be accessed here,

| Favarite Folderi All Folders ) Click to display the [All

=-{E) Desktop Folders] tab sheet
=8

My Documents
T AT

Click

BT
&l Search Resulks

Add to Favorites

@ When creating a folder, refer to p.24.
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Introduction
Start up EOS Utility. Connect your camera and computer and turn the
Click the buttons [Acquire & Camera Settings] > [Connect to camera on.
EOS Cameral. Connect the camera and your computer with the interface cable Table of
= _ , provided with the camera and turn the camera on. Contents
j Acauire & Camera S ettings . . . .
For detailed instructions on connecting your camera and
b i e ‘ computer, refer to the “EOS Ultility Instruction Manual” (PDF ]
electronic manual). OpBe1lt?0n
Connect to EDS Camera ]I
—=
Acquire Images from Memory Card ‘ =
Advanced
‘ Transfer Images to Memory Card ‘ ””CT] Operatlon
EOS Utility starts up. ! : %\\?D
High-Level
Functions
OS Utility _ » When the dialog box below appears, select [Canon EOS Utility] Preferences
L& cos.uulity Ld and then click the [OK] button.
Gontrol Camera
Canon EOS XXX
Camera connected REiEnEE
Select the pragram ta launch for this achion;
[ ] Contents
""\I—_-r_ Canaon Camerata/indaw Lookup
=¥ Downloads Images From Canon Camera
es from EOS camera
”‘ Monitor Folder Index
: _i7== Microzoft Scanner and Camera Wizard

Dowwrload pictures from a camera or zcanner

[ ] &hways uze this program for this action

ok || cancel @
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Introduction

Download images. | Downloading Images Using Your Card Reader
o e You can also download images to the computer using a third-party card

Control Camera \coessories Table of
‘7— reader. Contents

Select the save destination for the images (p.7).

Starts to download images Clle B1I c
. Opern@tion
Lets , Load the memory card into the card reader. '
ets you select and download images
Camera settings/Remote shooting Advanced
Operation
Monitor Folder
High-Level
A
Downloading of images begins.
The downloaded images are saved in the folder selected in step When the dialog box below appears, select [using Canon Preferences
1 and are displayed in the main window of ZB. ZoomBrowser EX] and then click the [OK] button. ZB starts up.
The downloaded images are sorted into folders by date and :
EOS_DIGITAL (F:) X
saved. -
Click the EOS Utility [Quit] button to exit EOS Utility and turn the . This ik ordevice contains marethen one ype o eterence
. Cantent.
camera’s power switch to < OFF >,
What do pou want YWindows to do?
= uzing Microsoft Scanner and Camera Wizard s Contents
= .. _ . Lookup
":EI Yiew a slideshow of the images
= uzing “Windows Picture and Fax Yiewer
L\ Print the pict
i-:,g% ugirr]'ug F'T'uoptlﬁ ;[r.iar'iing Wizard Index
whioad lmag

on ZoomB rowser EX

'y Open folder to view files
..-/ uzing "Windows Explorer @ @
® Take no action

A/ A
=@ Advantages of using EOS Utility to download images g @
kK Cancel

Using EOS Utility to download images makes it easier to organize your
images as they are downloaded, sorted and saved into folders by date. Proceed to step 4.
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Introduction

Start up ZB. Download images.
Click the buttons [Acquire & Camera Settings] P [Acquire Download images window
Images from Memory Card]. Table of

ZoomBrowser EX canon Contents

8 Acquire & Camera Settings

Connect to Camera

[ Download Images ] Click B1ic
Ope

tion

Connect to EOS Camera [ Lets you select and ]

download images

Acquire Images from Memary Card II [ Print Menu ]

= Advanced
Transfer Images to Memory Card Operatlon
Preferences... Exit
Download images window appears. | _
» Downloading of images begins. ';E’rr‘ctﬁg‘r’]‘;'
» The downloaded images are saved in the folder selected in step
1 and are displayed in the main window of ZB.
» The downloaded images are sorted into folders by date and
Preferences
saved.
© Click the [Exit] button to exit Download images window.
Reference
Contents
Lookup
Index
=@> Advantages of using ZB to download images @

Using ZB to download images makes it easier to organize your images

as they are downloaded, sorted and saved into folders by date. 10



Viewing an Image

Images downloaded to your computer are displayed as a thumbnails list
in the main window. You can double-click a thumbnail to open the
viewer window and display the image at a larger size.

View Images as Thumbnails in the Main Window

Click to select the image
Main window

F . = . —_r=
£ ZoomBrowser EX - C:\Documents and Settings\Adminidtratoriy Documentsiy Pictures FExX
File Edit View Tools Internet Help
Tasks Q | (B view mece Properties || Slide Show L_& Search T Delete ﬂ Rotate
[ et
(8] toie & Camera Setings Zoom bode | Serl Mode | Preview Mode
I]"l, View & Classify My Pictures (€] Q R-0-|k|" e | F e -
£ Edt
i=p/ Export
i PrinttEmal
r
{72 CANON MAGE GATEWAY
Last Acquited Images (2]
= ) All Images
=71 Shooting Date
28] wooc_xx_01
22 xxxx_o_02
] oo 03 N
28] woox_xxe_04
| Favoie Folders| Al Folders
5@ peskeop
=) My Documen ts
) My Music
1= (% My Pictures
9 My Computer
7 Search Results

Selected Items: |

Display thumbnails of all the
images inside the folder selected
in the folder area on the left

To select multiple images, click on the images while holding
down the < Ctrl > key on the keyboard.

-Z@/E Simple Display Function

Move the cursor over the image with the Simple display window

mouse and you can check images that
are displayed in the simple display - '
window (mouse over window).

To deactivate simple display, click on

[ 9 ] on the top of the window, select
[Show Mouse Over Windows] from the
menu and remove the check mark.

ﬁl For a list of the main window functions, refer to p.68.
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Enlarging a Selected Folder

Images downloaded to your computer are displayed in folders in the
main window. Double-click on an empty part of the folder you want to
enlarge to zoom in and display the images inside that folder at a larger

size.

Enlarge folders.

Toals  Int
Tasks

(78] Acauie & Camera Setings

O | Eavewtne

Zoom Made | Scrol Mode | Previen Mode |

s ];[shdeshaw Lgs%y(h 1 oelte [ rotte

=

& oot

&5l rintens

[2F(2H3H13 2

Cox 04

Fovrts Fldrs| Aol |

=@ oo
2 My Docunen

Am

My Pictures. (€]

DER D

Selected Items: 1

The folder you have double-clicked zooms in.

v

Double-
click on an
empty part
of the folder

Tacks [2]

W] Accpmn & Comen Seltesge

l': CANDON MAGE GATEWST

Lt Arguned Images (=]
) A Images
] Sheting Dabe
H] wrn e 01
B o0 o 02
) sooo_ee 09
) oo 04

il

Farvorie Folders | Al Foldert
= [ peskton
= (L) My Documants
2y e
€5 My Pctres
£ wexa i O
L xnx_wx 02
L o _jek G
) o0 _c_ O
1§ My Computer
3 searchRenss

7 FoomBrewse £ - C:\Documents and SettingsWdministrator by Documems\y Pictnes

Fle EdU Vew Tock Internet relp

:Jmm .ﬁzr.mm

ZoomModt | Seiol Mode | Preview Mode

Q00 H-0-(r]9

IMG_0007. PG IMG_000E.FG  IMG 0009. PG IMG_O010. PG IMG_0011L. PG  IMG_0012.FG

MG 0013 PG IMG_0014.FG  IMG I015. PG IMG_0016.FG

= e -

)
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Selected Thems: (1

To revert to the folder size before enlarging, click | ﬂ ] on the top

of the window.

@ You can change the speed at which a folder zooms in (p.61).
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Introduction
Changing the Display Magnification Enlarging and Viewing Images One at a Time
If you have many images inside a folder and they are small and difficult ] ]
to see, you can change the display magnification and display the Double-click an image to enlarge. Table of
images at a larger size. Double-click Contents

Change the display magnification.
Drag to the right

ic
Opernation

= = = Advanced

Show @ Search :7 Delete | Rotate Operation
Q00 R-0-1r % 0= &~ -

High-Level

[ w02 Functions

You can also change the display magnification by clicking [ '*,, ]
or[=L1]. s
The display magnification of the images changes. Preferences

eeeeeeeeeeeeee

=» The viewer window appears.

Navigator window

Reference
Contents
Lookup
Index
Enlargement
display position _—
Drag to move the
B enlargement
= . TS : .
1 — display position
The [Navigator] window appears and you can check and move
the enlargement display position.

You can also move the enlargement display position by clicking
[« 1] on the top of the window and dragging over the window.
To return to full view, click [ .. ] on the top of the window. 13



Click [ (2] or [ € ] to switch to the image you want to
display.

Viewer window

| Q = oL e - 28| show: ‘E|E 0O 0 &=
f

¢ ¢ IMG_O00LIPG (1 16)

Zoom Ratio: 22%

The shooting information is displayed by clicking [ =& ] on the
top of the window.

To exit the viewer window, click [ £ ] on the top right of the
window.

? When you display RAW images in the viewer window

The [Display Original Image] button appears at the bottom of the
window. Click this button to display the processed image.

@ For a list of viewer window functions, refer to p.71.

Displaying an Image Across the Whole Window (Full View Display)

Double-click on the image you want to display
across the whole window.

—— Double-click

® You can also display the image across the whole window by
clicking [ [=7 ] on the top of the window.
=» The image is enlarged and displayed across the whole window.

To return to the viewer window, click on the window or press the
< Esc > key on the keyboard.
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Printing an Image S
This section explains how to print one image on one sheet of paper, and Display the print settings window.
how to print using Easy-PhotoPrint EX. Click the buttons [Print & Email] » [Photo Print].
o ‘@J Print & Email ‘ (-:rgrt:':gnotfs
Printing One Image on One Sheet of Paper v— “
ata Frint
You can print one image on one sheet of paper. ]
Index Print ‘ o B1Itc
. . ernation
Select the image to be printed. E asyPhotoPrint EX '
Click Phata Print ‘
Create and Print Albun ‘ Advanced
ZnBse cms and SettingsMdministrator\by Documentsby Pictures O p erat | on
73 P — o @V‘iwm'ﬁﬂf‘mmw R @ e [y Frint sing Other Software ‘
% S Z;zmp::jsmwmd Proview Mods| 5 SN « T =T
= || . The [Photo Print] window appears. High-Level
£ E Functions
CE 4 Set the paper size and other settings, and then click
' the [Print] button. —_—
Photo Print window Preferences
#7 ZoomBrowser EX - C:Wocuments and Settings\A dministratoribly Documentsidy Picturesisoooc o 02 FEX
e @ G T Reference
3 Frint __Pmpemes
o
To select multiple images, click on the images while holding Contents
down the < Ctrl > key on the keyboard. ooy oo Lookup
You can select all the images inside a folder by clicking on an
empty part of the folder.
Index
Phata: 1/1 Copies Total: 1 pages @ @
(<Poviows ([P ]) [_concel ]

Printing begins. @

@ For a list of photo print window functions, refer to p.72. 15



Printing an Image Using Easy-PhotoPrint EX

If you have an inkjet printer that is compatible with the Easy-PhotoPrint
EX (hereinafter, “EPP EX") software for Canon printers, you can start up
EPP EX from within ZB and easily perform high-quality photo printing.
To perform this printing, it is necessary to first install EPP EX version 1.0
or later on your computer.

Also, Easy-PhotoPrint users can select [Easy-PhotoPrint] in step 2 and
print following the same steps.

Select the image to be printed.
Click

7 ZoomBrowser EX. - C:\Documents and Settings\dminiltrator\iy Documents\y Pictures

[S](=E]

L e
& oot

&5l rintens

B oo sarevn

To select multiple images, click on the images while holding
down the < Ctrl > key on the keyboard.

You can select all the images inside a folder by clicking on an
empty part of the folder.

Start up EPP EX.

Click the buttons [Print & Email] » [Easy-PhotoPrint EX Photo

Print].

‘ ] Print & Email

Phiota Print

Index Frint

E azy-PhotaPrint Ex
Photo Print

Create and Frint Album

Frint Uzing Other Software

= EPP EX starts up.

Specify the number of copies to be printed and then
click [Select Paper].
Easy-PhotoPrint EX

% Mew Phato Print - Easy-PhatoPrint EX

Specily the rumber of copees 1o print for ach imags.
Photo Print Ta conect of arhance mages. chck the Conect/Erhance buton.
Agply consctions and enhancemants nthe eeulting soietn
+
I’l' Select Images
[® e inic E ‘ -
@ Layout/rrint | |uo_ow1.n=o IMD_0002JFG m«umun
_—- =] (I 1 1] -
1M 0000 6 MG_E000IPG 1HAG_D010IP
|1 ][=] [ 1 ][=] w|[ 1 (=]
1 D018.2P 0 I 0010.P G
Slectons 16 mage{s]
o= L
T
. — IMG_0001... MG_0002... IMG_0003... IMG_0004__ IMG_0005... MG_0006... IMG_0007 ... IMG_0006.
Exit <

M0_0012 0P 160013 05

=[] [ 1][=]

1L

IMG_0008... IMG_0010... IMG_0011... |MG_0012.. MG_0
E3

— B SonbyDor &

Exif Print

o
- ‘ ‘_'

S

FNE

Click to increase the number of copies to be printed
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Specify the paper size and then click [Layout/Print].

% Mew Phato Print - Easy-PhotoPrint EX

Ble Edt Yiew Heln

Photo Print

Select the printes 10 ute, then telect the tize snd type of pager lor printing.

iy Shewd Frander

Noﬁol’g:

Exif }’ﬁnr

N D :| I ]
5 Lt a4 Pl Papes Pio. Fhato Pager Plus Phaks Papr Pz
138em 85T Gusy Gilosay I
|
Faiie
[ -':'-)
e Ae 1] PhotoPapes Plus  Glosty Photo Paper  Matte Phato Paper
1A A3 1Y =
Tkiem aoh Semichon
Fine Ast Latter Fine st A3 Fine Aut e
1 147 ol
2530em o dom 1020

. ) ] Introduction
Specify the layout and then click the [Print] button.
-'NI-‘ Pr - Easy-PhatoPrint EX i ]
— Exif Pria Contents
sl 98 @ e
f =:
| @ setect imanrs L
_i_ oideries B ordered (hull) |
@ sameomm ]| T ic
- Open@tion
[_'3: Lavout Print
Advanced
Operation
High-Level
Functions
—|| Uik
E e O B ) R |
0 Frin . . 5 " 5 ) . . . = Preferences
=» Printing begins.
Reference
Contents
Lookup
Index

|§| You can also create an album with EPP EX by clicking the [Create
and Print Album] button in the menu in step 2.

00
©
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Exiting ZB

In the main window, select the [File] menu P> [EXit].

Bé@Sic
Operndtion

( )
=» ZB exits.

o .
©o ...EEH...

=
o



D Advanced Operation —
Introduction
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Enlarging and Checking Images One at a Time........ 20 Viewing Images as a Slide Show ............cccccceeeeeeee. 36 Table of
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Automatic Adjustment Using ZB............cccovvvvvvevrnnnnnne. 29 Index
Adjusting Brightness, Color and Contrast.................. 31
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Correcting Red-Eye Manually...........cccccovvvvveennnnnne. 35
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Checking/Sorting Images

You can enlarge images one at a time from a list in the main window and
check what they look like in detail, and sort them into one of three
groups with [ <7 ] (ratings).

Enlarging and Checking Images One at a Time

Double-click on the image on the top left of the main
window.

Double-click

[S](=E]

£ ZoomBrowser EX_ - C:\Docun
5

ttttttttt

xxxxxxxxx

eeeeeeeeeeeeee

The viewer window appears.

Click [€2 ] or [ €3] to switch to the image you want to
display.

Viewer window

| 9 = o et - 25| show: |E‘E O M B
Fam .

¢ ¢ IMG_ODDLIPGL [ 16)

Zoom Ratio: 22%

@ The shooting information is displayed by clicking [ =& ] on the

top of the window.

To exit the viewer window, click [ [£4 ] on the top right of the
window.

When checking RAW images, always click on the [Display
Original Image] button and check the processed images.

=)= To display only selected images in the viewer window

Select multiple images in the main window (p.11) and then click on

[ [@a] viewmag=] ] on the top left of the main window (p.68) to display only

the selected images in the viewer window.

|§| For a list of viewer window functions, refer to p.71.
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Introduction
Enlarging a Specific Part of an Image Sorting Images
Enlarge an image. You can sort images into one of three groups by attaching [ -, ¢ ] (ratings) S
[=] ZoomBrowser EX - C:\Documents and accordm.g to photo SUbJeC.t or theme. PIe_ase note that [ ¢ ¢ ]is Contents
: — automatically attached to images shot with your camera.
File Edit Wiew Help
GO @ a i | K Increase or decrease a rating. Basic
T —— ; Operation
A= LI @ﬂ W T el IV‘ Drag to the rlght =] ZoomBrowser EX - C:3Documents and Si
You can also change the display magnification by clicking [ ‘%, ] i ey b A cd
or[=L1]. @ 9 X Opa‘?on
The image enlarges and the [Navigator] window appears. = @& ] .
Display the part of the image you want to check. ' ' Bt B
Drag the enlargement display position in the [Navigator] window - Functions

and display the part of the image you want to check.
Navigator window

Click to increase
Click to decrease

Preferences

Reference

Enlargement
display position Contents

Drag to move the Lookup
enlargement
display position

Index

Enlargement ratio
You can also move the enlargement display position by clicking
[<"7 ] on the top left of the window and dragging over the window.

To return to full view, click [ =" ] on the top left of the window. @ @
2 Enlarging RAW images @

RAW images cannot be enlarged before they are processed. By clicking
the [Display Original Image] button on the bottom of the window, the
image is processed and it can be enlarged. 21
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Arranging Images in the Main Window

Extracting Images You Want to Display (Filter
Display)
You can extract images displayed in the main window by the number of
[ <.r]you have attached to them (ratings).

You can arrange images in order of how many [ - ¢ ] you have attached
to it (ratings), or according to the image’s shooting date and time.

Select the [View] menu P> [Sort by] P> desired item.

The images are arranged in the order according to the selected
item.

Sort item Description

Star Rating  Images are arranged in the order of the least number of [ - r ].

Name Image file names are arranged in the order of 0 -9 - a - z.
Shooting Date Images are arranged in the order of most recently shot.

Modification Date Images are arranged in the order of most recently updated.

Type Images are arranged in the order of BMP images —
RAW images = JPEG images - TIFF images.

Ascending Images are arranged from top to bottom in order of sorting criteria.
Descending Images are arranged from bottom to top in order of sorting criteria.

Click the [ ] button.

y Pictures Q@E|

[ :
Shiow ‘\xSearch ‘.:’7 Delete ‘&g Rotate

Q00 @RO-[r|R

—(E=)

| wamn_wx 02

=» The extract function appears.

Checkmark the number of [ ¢ ] you want to extract

and display.

Settings\Whdministratoriy Documentsiy Pictures

—_ — - : == ;
T = i i ¥
il | Wiew Image !E—-:: Properties 7’" Slide Show | { Search J'? Deel

| Zoom Mode Sl Mode || Preview Mods
My Pictures Q Q Eﬁ N
Filter by Star B ating: [ e L L A8 AL ,"]

Only the images with the number of [ - ¢ ] you have checkmarked

are displayed in the main window.

To exit the extract display, click the [ ] button again.
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Efficiently Checking/Sorting Images

With Preview Mode that displays images as thumbnails and as single
images in the same window, you can sort images by the number of

[ < 7 ] while checking efficiently. You can also simultaneously check
shooting information for images.

Enable Preview Mode.

| SettingsMidministratoriy Documentsiy Pictures

Properties :.; Slide Show L& Search Fﬁ Delete @Rotate

Zoom Mode | Serol Mod{ Preview Mode ]
——
Iy Pictures Q

; Wiews Image

QO R-0-[r|n

Click
The main window display switches to Preview Mode.

)

Introduction
Click the | ]orthe[ ] button
to switch to the image you want to check, and then
sort with the number of [+ ¢]. Table of
. . . . nten
The selected image is enlarged in the center of the window Contents
Click to increase or decrease
45 ZoomBrovser 5 - G:llocumant om Sttnpsiansroorty ocumanay Pt | GBI Basic
File Edit Yiew Tools Inkernet Help — . - Op eratlon
Taske Q| & imooe & Search [ Delets @Rumte
L8] gt Camers S lings Zoom Mode | ScrollMode | P
‘:ﬂE Viewd Classiy ||| e 01 v F Fiter -
=L e : 3
L:i‘ _ ;o:/}:gma [ Pratect
§J Print & Email e ]Jig;xzaaz
(:‘ CANON IMAGE GATEwAal
Last Acquited Images (4] 1 .
High-Level
| —— Functions
Preferences
4 Previous MNest >
Reference
L‘ - 7 7 7 7 : ‘ 7 7 Selected Items: 1 ) ’
Thumbnail image display area Contents
. . . - . Looku
You can also click on the image in the thumbnail image display P
area to display the image enlarged in the center of the window.
When checking RAW images, always click on the [Display Id
L . . . ndex
Original Image] button in the viewer window and check the
processed images. —

? When a folder icon appears in the thumbnail image display area

You can double-click the folder icon to display the images in the folder in
the thumbnail image display area.

|§| For a list of Preview Mode functions, refer to p.70.

23



Organizing Images
This section explains functions that are useful for organizing images

such as creating new folders for saving sorted images, moving and
copying images and deleting unwanted images.

Creating a Folder for Saving Images

You can create a folder to save sorted images.

In the folder area, select the location where the new
folder is to be created.

Last Acquired Images @

| Favorite Folders | 41l Foldsrs

| = (&} Desktop
=2 u My Documents
d My Music

=¥ My Pictures
120 w01
1) waonm o _02
1) o o _03
120 w04

Ej@pumr
iy
3 Search Resulks

Add ta Farvorites

Select the [File] menu P [New Folder].

The [New Folder] dialog box appears.
Enter a folder name and click the [OK] button.

= =» The new folder is created in the folder selected in step 1.
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Moving Images

You can move or copy images to separate folders and organize them
according to shot date or theme.

Moving Images in Folders

You can move or copy folders that contain images, and organize images
in folders.

Drag the image to be moved or copied.
To move:Drag the image and release when the image is in the
destination folder.
To copy: Drag the image while holding down the < Ctrl > key and
release when the image is in the destination folder.

£7 ZoomBrowser EX - C:\Documents and Seftings\dministratoriy Documentsisy Pictures
File Edit View Tools Internet Help

U=te @ | Gal vewmese 4= propertes 2 siide show L_A search (7] peets @Rntate

8] Acquire & Camera Settings " Zoom Motz | Serol Mode | Preview Mode

](]11, iew & Clasiy My Pictures QOO0 R-0-|n]xy J—==| & Fe
;{ Edit
= Export

& Print & Emal

i; CANON iMAGE GATEWRAY

wtn_ww_001 wwn_wi 02

Last Acquired Images (7]

= %] All Images
=7 Shooting Dats
xx 01

] oo 2
2] e _03
B2 xoxx_oc D4

e

| Favarie Folders| Al Falders

Deskiop
=(5) My Documents
12 iy music
= (¥ My Fictures
{2 00m e 01
2 oo ex 02
{2 oooe_nx 03
{2 000 04
i My Computer
3 Search Resuts

Selected Items: |

The image is moved or copied to the folder it was dragged to.

|
\\/

=@ Moving images to a folder in the folder area

Drag an image in the main window to a folder in the folder area on the
bottom left of the window in the same way as described above to move
or copy the image.

Drag the folder to be moved or copied.
To move:Drag the folder and release when the folder is in the
destination folder.

To copy: Drag the folder while holding down the < Ctrl > key and
release when the folder is in the destination folder.

7 FoumBrwwser B - C:\Documments and SettingsVdoingstrator Wy Documents\y Pictines
Fle Edt vew Took Intennet ek
Taske o 4| Properties ] sae show o searen T Deietn
L g Eaal L -

W] Accpan & Comeen Seltrnge = P:dT_sanleb odd]

:fi.l Viewi & Claseiy My Pichace Q D H-0- |k S | Fam -
= s
e wr il ]
i] Friet L Emal .. a
R PR 10N
Q, CANON MAGE GATEWY w g

Laat Arqaned images

:’ — m_ =
Farvorte Folders | A Foldert ‘
=y il (3
e —=Bk—@
= ) My Documents
s EX
3 Py Peiures c 3 8
e o0 m—rns s mmrens
= ﬁﬁﬁﬂﬂ:
£ 0000 et 83
23 oo _ce_ 04 T P MR P
i My Computer
) SearchResuts
Selectd Trems: |

The folder is moved or copied to the folder it was dragged to.

Y

Z@= Moving folders in the folder area

Drag a folder in the main window to a folder in the folder area on the
bottom left of the window in the same way as described above to move
or copy a folder.
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Changing Image File Names or Folder Names

Select the image whose name you want to change in
the main window, or select the folder whose name
you want to change in the folder area.

Select the [File] menu P> [Rename].

The [Rename Image] or [Rename Folder] dialog box appears.

Enter the file name or folder name of the image and
then click the [OK] button.
The file name or folder name changes to the new name.

You can also change the file names in the [Properties] window
(p.46) or the image display area in Preview Mode (p.70).

You can also change the folder names in the [Properties] window
(p.46).

Deleting Images

Please take care as deleted images cannot be recovered.

Select the unwanted image in the main window.

Click [Delete].

| Settings\Widministratori¥y Documentsiiy Pictures

F— — = =
“I View Image |#== || Properties I}‘J Slide Show £ Search ‘.:’7 Delete :'3! Rotate

Zoam Made | Sergll Mo%"?ﬁ\{@odg |

My Pictures Q Q Eﬁ -9 - |}j| *

Click
=» The [Confirm File Delete] dialog box appears.

3 Click the [Yes] button.

=» The image is moved to the [Recycle Bin] and is deleted from ZB.

©® Right-click [Recycle Bin] on the desktop and select [Empty
Recycle Bin] from the menu that appears to delete the image
from your computer.
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Deleting Folders

Deleted folders cannot be recovered. Please take care as all images
inside folders are also deleted.

In the folder area, select the folder you want to
delete.

Select the [File] menu P> [Delete].

The [Confirm File Delete] window appears.

Click the [Yes] button.

The folder is moved to the [Recycle Bin] and is deleted from ZB.

Right-click [Recycle Bin] on the desktop and select [Empty
Recycle Bin] from the menu that appears to delete the folder
from your computer.

Registering Frequently-Used Folders as Favorite Folders

You can register shortcuts for frequently-used folders in the [Favorite
Folders] tab sheet in the folder area to make images easier to find.
Please note that because the [My Pictures] folder is registered as a
favorite folder by default, the folder icon appears as [ (¥ ].

Select the folder you want to register.

Lazt Arquired Images @

sacqUired frorm yaur
ca CCESS Bre.

a T WY

Favorite Folders | All Folders |_

—"E Desktop
E\ ﬁ Iy Diacurments
’ : My Music
 B¥ My Pictures
i 1) o o011
| | 1) o _sew_02
120 st o _03
1) o o014

Eﬁpumr
bt
3 Search Resulks

Add to Favorites

Click the [Add to Favorites] button.
The folder icon changes to [ IL% ] and is registered as a favorite
folder.
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Select the [Favorite Folders] tab sheet.

Select the registered folder to display the images

inside the folder.

Last Acquired Images

Favorite Folders | &)l Falders

E-% My Pictures
1) e _01
120 w02
1) oo e _03
Lo w04

A)

g‘ Phol tllj l

earch Resulks

[ Add... ] [ Remove

]

Click

The images inside the folder appear.

? If you have edited or deleted images in folders you have

registered as favorites

Any changes done to images inside registered folders will be applied to

the original images. Therefore, please be aware that by editing or
deleting images inside registered folders, you are in fact editing or

deleting the original images.

Deleting Favorite Folders

If you no longer need a folder you have registered in the [Favorite
Folders] tab sheet, you can delete it from this tab sheet.

Please note that as registered folders are shortcuts, the original folder
will not be deleted when you delete the shortcut.

In the [Favorite Folders] tab sheet, select the folder
you want to delete and then click the [Remove]

button.

Lazt Arquired Images

ges acquired From ame
an be accesser

Favarite Folders [ Al Folders

[ =¥ My Pictures
) o _oe_01

| | ; 120w e _02
120 o _03

] e ¥x_04

A

[ Add... ]l[ Femave

The folder is deleted.
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Editing an Image

If the brightness or color of images is different from what you visualized
when you shot the photo, you can adjust an image using the editing
functions to bring them closer to what you visualized.

This section explains about automatic adjustment of images, adjustment
of brightness, saturation and contrast, trimming images, inserting text
into images, adjustment of sharpness and red-eye correction.

JPEG images deteriorate slightly when edited and saved, and the image
before editing cannot be recovered. For this reason, an edited JPEG
image should be saved as a separate image from the original image.
Chapter 3 explains about high-level editing functions other than those
described above.

@ You can edit RAW images in Digital Photo Professional (hereinafter,
“DPP"). Select the RAW image in the Main Window and click the
buttons [Edit] » [Digital Photo Professional Process RAW images],
which will start up DPP. For detailed instructions on using DPP,
refer to “Digital Photo Professional Instruction Manual” (PDF
electronic manual).

Automatic Adjustment Using ZB

The brightness and colors, etc. of the image are automatically adjusted.

1 Select the image you want to edit.

2 Click the buttons [Edit] P> [Edit Image].
‘ﬁ Edit

Edit Image

Stitch Photos

Digital Photo Profeszional
Process Rahw' Images

-» The [Edit Image] window appears.

3

Select the buttons [Auto Adjustment] P [Finish].
Edit Image window

BT ZoomBrowser B - Co\Dociments and Settings\dministrator

ZoomBrowser EX determines
which lool 1o use based on e
typ Of COMRCHon you war i
mika

‘v'ou can also edit the phato with
on exemal image editor.

alarEnghtnss Adjustmant
) Shaprnss

O Tram

O Inser Text,

O Editwh extemeal image editor,

Use this task to comect photos of
subjects with red-eye, adjust
shotos ically, change

editor.

3 Ritum to bsin Meou J

=» The [Auto Adjustment] window appears.
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Click the [Auto Adjust Image] button.
Auto Adjustment window

Window in enlarged display

=] Auto Adjustment - C:\Documents and Settings\i dministratoriy DocumentsiMy Pictures... |:|@@

- BX

= Auto Adjustment - C:\Documents and Settings\dministratoriMy DocumentsiMy ...

MNavigator

.t 4 [[ Auto Adjust Image ﬂ

[ Show Driginal Image

Q] |

)
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Save fs.. ][ Cancel

Save As.. ” Cancel

Enlargement display position
Drag to move the enlargement display position

The image is adjusted.

Enlarge the window and check the adjustments. ® To revert to full view, click [ “&

' Click the [Save As] button and save as a separate
|mage

| Save Az l Cancel

The [Save As] window appears.

‘ Drlag right to enlarge
Fits the image to the window size
Moves the enlargement display position
Zooms in/Zooms out

Specify the save destination and then click the

[Save] button.
The edited image is saved as a separate image from the original
image.

In enlarged view, the [Navigator] window appears and you can
check and move the enlargement display position.

“ ] on the bottom left of the window.
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.30).
You can adjust the brightness, color (saturation) and contrast of images. (p-30) Table of
Click the [Save As] button and save as a separate el
Sel_ect the image you want to edit and display the image (p.30).
[Edit Image] window (p.29).
Basic
Select [Color/Brightness Adjustment] and then click Operation
the [Finish] button.
The [Color/Brightness Adjustment] window appears.
Adjust the image.
Drag to the left or right to adjust
Color/Brightness Adjustment window _
High-Level
[=] Color/Brightness Adjustment - C:3Documents and Settingskidministratoriyy Docume Functions
Pleaze zelect adjustment option:
| Color Adjustment w | —
[ o Preferences
| Saturation: __j__
Contrast: i_
Reference
Contents
Lookup
Index
QM| = - @
[ Save bz, ][ Cancel ]
Move the slider to the right to make the [Brightness] of an image @ @
appear brighter, the [Saturation] to appear more vivid and the
[Contrast] stronger. Move the slider to the left to make the image @

appear darker, and the saturation and the contrast weaker.
The image is adjusted.
31
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Trimming an Image Click the [Trim Image] button.
You can trim only the part of an image you need, or change the Gl LU R Table of
composition of an image where an image shot horizontally becomes l = ) antgnots
vertical. —
Selt_act the image you want to edit and display the The image is trimmed. o Basic
[Edit Image] window (p.29). _ gl
_ _ o Click the [Save As] button and save as a separate
Select [Trim] and then click the [Finish] button. image (p.30).
The [Trim Image] window appears. Ad@ed
Op ion
Drag the trimming range.
Trim Image window
" 3 - ; = High-Level
[=] Trim Image - C:Wocuments and SettingsthdministratoriMy Documentsiby Picturesbooor e 011MG... |._|E|Fz| Fu nctionS
The image will be timmed to the area shown inzide
thie trim box.
1. Mowve and rezize the tim box in the preview area,
F¥] Advanced Options Preferences
2. Click Trim Image to apply the settings
Trim Image
Red Reference
3. Click Save As to close this panel
Contents
Lookup
Index
|i| S =N }"_'_'_‘ - @
Zoom Ratia: 11% ¥ 388, 269, Width: 3112, Height: 2074
Drag @ @
The trimming range can be moved by dragging. @‘
You can change the trimming range by dragging the four corners -

and the four sides of the trimming range.



Inserting Text into Images

You can insert the date and time you shot an image and text into an
image as text.

Select the image you want to edit and display the
[Edit Image] window (p.29).

Select [Insert Text] and then click the [Finish] button.

The [Insert Text] window appears.

Drag the range for inserting text.
Insert Text window

=] Insert Text - C:iDocuments and Settingskhdministratoridy DocumentsiMy Picturesboooc x... |:|®

Inzert Tewt:

Fant Size:

!a

Text Colar:
| Testétrbue: B 7 U
[#] Antialias

Text:

[ Import Comment ]

[ Import Shooting D ate/Time ]

(TR Q O M8 s

Save As... H Cancel

Drag

The text insertion range can be moved by dragging.
You can change the text insertion range by dragging the four
corners and the four sides of the text insertion range.

&, Click the [Save As] button and save as a separate

-

Using the keyboard, enter the text you want to insert.

Antialias

Text:

5 2 3 (;

Impart Camrment

[ Import Shooting D'ate/Time

The text you enter appears in the window.

Image (p.30).
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Introduction
Adjusting Sharpness En?!glrge the window and check the adjustments
You can make the overall atmosphere of an image harder or softer. (p-30). Table of
Click the [Save As] button and save as a separate e
Select the image you want to edit and display the image (p.30).
[Edit Image] window (p.29).
Basic
Select [Sharpness] and then click the [Finish] button. Operation
The [Sharpness] window appears.
Adjust the image.
Drag right to adjust
Sharpness window
&=l Sharpness - C:iDocuments and Settingsuidministratoriy Documentsivy Pictures\)ooé o O1VUMG_. .. |:||E|[1_(|
High-Level
Sharpen |U izharp Mask Func‘“ons
Amnunt
Preferences
Reference
Contents
Lookup
Unda &l ndo Fed
QDB [ Index

Move the slider to the right to make an image harder and to the
left to make an image softer. @ @
The image is adjusted.
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) Introduction
Correcting Red-Eye Manually

You can manually correct red-eye that cannot be corrected automatically.

Correcting Red-Eye Automatically

You can automatically detect and correct red-eye that occurs when you

; Table of
hot h I flash. . . .
photograph peopie tsing a flas Display the [Red Eye Correction] window (Description Contents
Select the image you want to edit and display the on the left).
Edit Image] window (p.29). i Basic
[ ge] (p.29) Enlarge the image (p.30). %

Select [Red Eye Correction] and then click the
[Finish] button.
The [Red Eye Correction] window appears.

Click the [Start] button.
Red Eye Correction window

[=] Red Eye Correction - C:\Documents and Settingsihdministratoriby DocumentsiMy PicturesiiMG_0201.JPG

Red Eve Conection:

() Auto Mode

(O Manual Mode

Unida

[ Show Driginal Image

The image is corrected.

Click the [Save As] button and save as a separate
image (p.30).

Select [Manual Mode] and then click [|=]].

Click on the places in the image you want to correct.
When you move the mouse cursor on the places to be corrected,

[ ()]is displayed.

=l Red Eye Correction - C:\Documents and Settingsbhdministratoriy Documentsidy PicturesiiMG_0201.JPG |Z|@E‘
Navigat;r 5 ﬁ Red Eye Comection:
d | OhutoMade

N
i (&) Manual Mode

ﬂ [ Show Original Image
- ! E

L |

High-Level
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Save As. Cancel

Click
The image is corrected.

Click the [Save As] button and save as a separate
image (p.30).
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Utilizing Your Images

You can view your images as a slide show, send them in an e-mail or
use them as wallpaper or screen savers for your computer.

Viewing Images as a Slide Show

You can display selected images across the whole window and switch
between them as a slide show.

1 Select images.

*) Click [Slide Show.

| SettingsMidministratoriy Documentsiy Pictures

|| View Image Properties Slide Show g Search @ Delete @Rotate

ZoomMode | Serall Mode || Preview Mode|
Iy Pictures Q . m - = |l| %
|

=» The [View as a Slide Show] window appears.

Set the slide show style and then click the [Finish]
button.
View as a Slide Show window

Shide Show Setngs

Use this task io create a shide
show from & group of photos.
either m the same or diferent
foldirs

The arder inwhich vou select

phatos determines their Image Size: © Acnl Size
sequence in the slide show.

| 3 R o bain bow |

& BostFit

Ol o [=ll=][t]1]
o EEEE
@ Show Information

e EIREIE

Advanca O On g
& Every 3 second(s)

LI

=» The Slide Show window appears and the slide show begins.
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Slide Show window

File name Rating setting
Selects the image*!
Prints the image*?
Switches to the previous image
Pauses the slide show
Switches to the next image
Ends the slide show

*1 The image is selected. When the slide show ends and returns to
the main window, the image is displayed as being selected.

*2 The image is selected for printing. When the slide show ends and
returns to the main window, the print dialog box is displayed.

=»When all the images have been displayed, the Slide Show
window closes and returns to the main window.
@ To end the slide show half-way through, click [0 ]

Sending an Image by E-Mail

You can attach a selected image to an e-mail and send it.

The attached image to be sent is a copy of the original image and
therefore the original image remains unaffected on your computer.
Please note that the e-mail software for attaching and sending an image
selected in ZB is MAPI-compatible software. Please consult the
Instruction Manual for your e-mail software for settings related to MAPI.

G
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1 Select an image.

2 Click the buttons [Print & Email] » [Email Images].
‘@ Frint & Email

Phata Print

Index Print

Eazy-PhotoPrint £
Phata Print

Create and Print Alburn

Print Uzing Other Software ‘

Email Images Il

=» The [Email Images] window appears.
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Select [Using the recommended settings.], and then
click the [Attach to Email] button.

Email Images window

Fle Edt vew Took Internet resp

nail Setng: [Reducing e iotal email size 1o

TME o less insunes thal others
AR e your aneges. To
raduce tha siza of the amail do
‘one of the following:

! - Click Custom Sefings 1o

A resize or sher the guality of
Use this task to atiach JFEG images
images to an email message. - Ristin to Step 1 and

reduce your selecton of
images. Consids semding
sewiaral emails with fewer
images.

Click Confirm Current Settings
o check the email afinchment
size,

Send these images:

i ;' i (@ Using thi recommanded smugs)

© Using custom setings,

¥ Conten Curerd Seftings
*fou can change image

quality 10 rrduce the s

email anachments.

| 5 Remiosabens |

I Amach to Email_|

4] Selected hems: 1

=

=» The e-mail software starts up and the image is attached to an e-
mail.
© Enter the address and a message and send the e-mail.

Creating Wallpaper from an Image
You can make a selected image wallpaper for your computer.

Introduction

The bitmap image for the wallpaper (extension “.BMP”) is created using ggmgn%];

a copy of an image and therefore the original image remains unaffected.

1 Select an image. Basic
Operation

2 Click the buttons [Export] P> [Export as a Wallpaper].

‘ @ Euport

Export Still Images

Export Shooting Properties

Export a3 a Screen Saver

Export az a W allpaper

Backup to CD

=» The [Export as a Wallpaper] window appears.
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Specify the layout and the save destination for the
wallpaper, and then click the [Finish] button.

Swetching small photos can
proelste and distort the photo,

) Install contined Try chodsing Irstall comened or
Installad ilad
) Install srotched Tiling replicates the photo, in its
ongnal sige, o 8 the deskiop.
Uze this task to create o ) Install vl
walipaper file that displeys on
rour desklop.
s S O Do notinstall
ou can savn the file 10 &
spaciied folder and share it with
yaurfrends. Save o File
| The wallpape: wil he taved as:

{3 Renmubsamens |

R

(%) "ZEWslipaper bang” in the defaull diectony lor wallpapers

) Spacity file namae and folder

HOTE: Wallpnpers will be saved as bitmap (*bmg) files.

E Firigh

4] Selected hems : 1

E

=» The image you selected for your wallpaper is applied as
wallpaper.

=» The image you selected for your wallpaper is saved in the
specified folder.

Selacted Thems: |

? To revert to the original wallpaper

1 On the desktop, right-click with the mouse and in the menu that
appears, select [Properties].

2 Select the [Desktop] tab sheet.

3 Select the file to become the wallpaper and then click the [OK] button.

Creating a Screen Saver from an Image

You can make a selected image a screen saver for your computer.

G

Introduction

The data for the screen saver (extension “.SCR") is created using a ggmgn%];

copy of an image and therefore the original image remains unaffected.

1 Select an image. Basic
Operation

2 Click the buttons [Export] P [Export as a Screen
Saver].

‘ @ Export

Export Still Images

Export Shoaoting Properties

Export az a Screen Saver

Export az a'wWallpaper

Backup to CD

=» The [Export as a Screen Saver] window appears.
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Checkmark [Include images in the screen saver] and
click the [Finish] button.
Export as a Screen Saver window

7 FoumBrewser £ - C:\Documsnts and Settingsudainistrator iy Documents\y Pictires

Fle Edt vew Took Interiet relp

E Export 85 & Screan Saver g expan settings

1 Select Imagas Soreen Ssver Sefings The order inwhich you select
T T ) phobos determenes ther
Specily Export Seltings =] Include images in the screen shver (larger file sizal SUGUBNGD i v SCTBDN SEVIY

Fesize images 10244768 - Hyou selected io includa
immpes in the screen saver. you
: Scron s size 0KE can reduce thew size 1 fito.
Use this task 1o creats a screen diierent scroen resolubon
saver for computar. -
ot Preview Screen Sear. E liyou choose not to include
o] Sev Wi ecvwar heitar images inhe screen saver, and
spacibod lokdar and haro i 0 Bhivn o or rename thise
::'Wm_ = 2 Sawn to File images, they will not display

whan the screen saver plays.

ETTT—

NOTE:

’;?‘P[ Spaciyfile name and folder Sevess. |
-

CAL and

Canon Ui\ 2B S cronnSaven 2B ScroenS e sor

find your screen
saverfile on the Windows
Sereen Sever tab, you need o
15t a3 detoult screen saver install it

Beowsa to the tolder that
canteins the screen saver file,
right-click on the file. and then
chek Instoll on the shorcul menu.

NOTE: Screen savers will be saved a3 Windows scraen sever (".scr) fles,

Selacted Toems: 16

The data for the screen saver is saved in the specified folder.

Specify the saved screen saver on your computer.
On the desktop, right-click with the mouse and in the menu that
appears, select [Properties]. Display the [Screen Saver] tab
sheet in the [Display Properties] dialog box.

Display Properties

Themes Desktap- Screen Saver |.f-‘«p|:|earance || Settings |

SCIeen s8ver

I[ Settings H Previgw

[| Zhzcreenzaver

'W'ait:[ 10 % | minutes [ On resume, password protect

bl onitor| poveer

Tao adjuzt monitor power setiings and zave energy,
d& click Power.

Poer. .

H Cancel l Apply

[

Applies the selected screen saver data

Select the saved screen saver data

=@ About the [Include images in the screen saver] checkbox

When you checkmark [Include images in the screen saver] in step 3, the
original image is copied to create the data for the screen saver. This
means that even if the original image is deleted or the file name is
changed, it does not affect the screen saver. However, if you remove the
check mark, the data is created using the original image, and if the
original image is deleted or the file name is changed, the screen saver
will not work properly.
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Writing Images to a CD

You can write selected images to a CD.

This function is only compatible with a computer that has Windows XP
or Windows Vista preinstalled and is equipped with a standard CD-R/
RW drive.

1 Insert a CD-R/RW disk in the CD-R/RW drive.
© When the dialog box below appears, select the [Cancel] to close
the dialog box.

CD Drive (Ez)

YWindows can perform the same action each time vou insert
a digk or connect a device with this kind of file:

%] Blank CD
Yw'hat do you want Windows to do’?

® Take no action

[ &ihways do the selected action,

L OF. ]' Cancel

2 Select the images you want to write to the CD.

—

3

Click the buttons [Export] P [Backup to CD].
‘@ Export

‘ Export Still Images

‘ Ewport Shooting Properties

‘ Export az a Screen Saver

‘ Export az a'Wallpaper

|| Backup to CD

=» The [Backup to CD] window appears.

Specify the settings for writing to the CD-R/RW disk
and then click the [Finish] button.
Backup to CD window

Zonmflrewser FX - CoDocuments and Settingsi dministrator by Documeats\ly Picturestoos s 01

L
Fle Edt View Tools Intemet Hep

Backup Semngs The spaed atwhich your

computar wiites (buens) dats o

Salect COHR Dinve: F - the CO abocts th CO quality.
COTia: In ganersl, slowar recording

speeds ceete COs thet are loss
Spaed: Fagtagt b prone o emors.

His alwanys o good iden to

choose ity sher backup' o
ensure that the backup was

camplote. This wil ger. P successiul

swecesshl,

[¥]'erity ahar backup.
Use the ety feabare ta test e dain on the CO-R aker backup i3
I bt will the

“The denvice that copias the
phatas 16 CO mus ba CO-R o
CO-FON. which means il con wile
o (burm) COs.

Space on CO-R:
BT Used 0.00 B Current Session 119.57 M8, Remaining 583.25 MB
{NNNNNRN

1) Thefile szes above are estimatas onky. The OO buming procass
iy 108 b completed if e remaining SRACS it w

E3) Salected tams - 16

Semp i B B

Selacted Jtems: 16

=» Writing to the CD-R/RW begins.

G

Introduction

Table of
Contents

Basic
Operation

High-Level
Functions

-

)

Preferences

)

Reference

Contents
Lookup

41



Printing Multiple Images on One Sheet of Paper (Index Printing)

You can arrange multiple images in index format and print them on one Specify settings such as the paper type and the
sheet of paper. number of prints, and then click the [Print] button.
Print preview

1 Select the images. Index Print window

ssssss

2 Click the buttons [Print & Email] P [Index Print].
‘@J Print & Email ‘ :
Phato Print ‘ - e e i -

Printer and Layout Settings

Inde:x Frint II e
rieetion

E azp-PhotoPrint Ex
Fhoto Print

Pags Layout Sefings
Columns

Riows:

Frint Using Other Software

[ Shaoiing Information == = s F E=F

[ Header/Faster \ J

Emaill Images

Create and Print Album ‘

[ Setings

Page: 1/1

=» The [Index Print] window appears.

Selected Items: 8

=» Printing begins.

|§| For a list of index print window functions, refer to p.73.
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3 High-Level Functions

C'

il

Comparing Multiple Images.........ccccvvvevvciieevveennnnnn. 44
Listing Images by Folder Level.............cccccceeeeeee 45
Viewing Shooting Information for an Image............. 46
Changing the Size and Type of an Image and
SAVING ottt 47
Exporting Shooting Information ..............c...cce. 48
Organizing Images Using High-Level Functions..... 49
Setting Keywords in Images.............evvvvviiviiennnnnnnnnnnns 49
Entering Comments into IMmages ..........c.cceevveeeieeeennns 49
Saving Multiple Images with New File Names............ 50
Classifying Images by Shot Date.............cccccvvvveeeeeenennn. 51
Searching for Images .........ccoooeviiiiiiiiieciieei, 52
Performing Advanced Editing ............ccooovvevivinnnnn. 53
Adjusting the Color of an Image in RGB..................... 53
Adjusting the Brightness Level ............ccccoevvviieinnnennn. o4
Adjusting the Tone Curve........cccccceeeeeeeeeveeeiceee e 54
Unsharpening an Image ..........cccoeveeeiiieiiiiiiiniee e, 55
Transferring Images to Other Image Editing Software... 56
Merging Images to Create Panorama Images............ 56
Adding Sound to Images/Playing Back.................. 58
Adding Sound to IMages .........ccvvvviiieieiiieeeiiiee e 58
Playing Back Sound ............coviiiiiiiiiiiiiiiicieeeeeeeeis 58
Printing Using Other Printing Software .................. 59
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Comparing Multiple Images

To compare multiple images, you can split the viewer window into two,
three or four and display multiple images at the same time.

You can also align the display position of enlarged images and compare.

In the main window, select the images you want to
compare (p.11).

Click [ [aalvenmace] ] (p.68).

The viewer window appears.

Select the number of images you want to display at
the same time.

ratoriy Documentsiy Picturesboooc o 014MG_01

The viewer window is split and the multiple images are displayed
at the same time.

v

Example of display when [ = ] is clicked

Exl FovmnBrmsesnr EX - 03\,

) e B p | MO mLwG(fe ) e Bt uf o MaDIRMEE/G

L7 HEBI0R G {1 4)

Click [Synchronize] and then enlarge the image.

Wy Documentsiiy Picturesbooo: xoc 01MMG_0101.)

mw: D E D] D:D |E“@ Synchronize“‘. Click

Drag right to change the display magnification

v B 28 e O O [ 00| swrtroin

o1 NEDlE WG 2] 4}

The synchronize display appears and all the images are
displayed at the same display magnification and in the same
position.

The [Navigator] window that displays the enlargement display
position appears and you can check and move the enlargement
display position (p.21).

Click [Synchronize] again to cancel the synchronize display. You
can now change the display magnification and move the
enlargement display position for each image.

To return to full view, click [ .E. ] on the top left of each window.
To cancel the split display, click [|:| ] at the top of the window.
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Listing Images by Folder Level

You can switch the main window display to Scroll Mode that displays in folder

levels and simultaneously view multiple folders and images inside the folders.

You can also set the level to which images and folders are displayed in the
window, which makes looking for the folders and images you want easier.

1 Click the [Scroll Mode] tab sheet.

| Settingsuidministratoriy Documentsiy Pictures

— o o .
ol Wiew Image Properties Slide Show g Search "r}:ﬁ Delete @ Rotate
Zoarm Mads] | Scroll Made 'F'review Mode|

iy Pictures @
I

=» The display in the main window switches to Scroll Mode.

2 Select the [Tools] menu P [Preferences].
-» The [Preferences] window appears.

Q R-0- |E|*\x

Change the depth of the folder level to be displayed.

1 Preferences Z
| Frinting |l Shooting Information || Themes |
General | Selection | Fiotation |
Thurnbrait
Minimum vigible thumbnail size: pirels
Minimumn clickable thumbnail size: pixels
Zooming:
Smooth 73— Fast

Color Managemeant:

[ &diust color of images using moritor profile

‘wiarn me when hiding files uging the Filker Tool

M aximurn scroll mode folder depth:

L Ok ] [ Cancel

Click the [OK] button.
=» The main window is displayed at the folder depth you set.

Example of display when you have set the folder level setting [3]

£T ZoomBrowser EX - C:\Documents and Settings\administrator\DesktopiPhoto
Fle Edi vew Tools Internet Help

Teke O @l vewinee Pvupemes @shde Show &Sear:h 1) osete By Rotate

L8] scauie & Camera Setings ZoomMode| SoioliMode | Preview Mode|

% View 1 Classiy IRt TN R — NG s
2{ o 1001000 ( 0=, 02),30)
=

i PintEndl

ei CANDN iMAGE GATEW/AY

Last Acquired Images [2]

kop
¥ o
-8

- & W Comer
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233 Photo —_——
& 1) 001000 3
= l’c; Preferences
L J
Click Number of images inside the folder Reference
and number of folders
=» Folders up to the third level and images inside the folders are Contents
displayed in the window. Lookup
@ Folders at or higher than the fourth level are displayed as folder
icons. Double-click these folders to display images and folders
inside the folders. Index

|§| For a list of Scroll Mode window functions, refer to p.69.
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Viewing Shooting Information for an Image

Enable Zoom Mode (p.68) or Scroll Mode (p.69).

Select the image for which you want to view the
information.

Click [Properties].

| SettingsMidministratoriy Documentsiy Pictures

;.] Slide Show @ Search Fi’j Delete @ Rotate

Iy Pictures Q (1] @ -0 - |E| *

; Wiews Image

The [Properties] window (image information window) appears.

v

Properties window

i1 Properties
Modified: pefrtesiad

File Size: B3 ME
Image Size: 3888 » 2552
[ata Tupe: APG

Sound:

e

Path: C:\Documents and Settings'Administratartdy

File: M ame:
[1MG_noo1

Star Rating:
PR G ¢

Comment:
FKepwords:

Brightness Histogram:

CANAI

Shoating Information:

Item Mame Walue
File Mamne IMG_0001.JPG
Camera Model Canaon EOS 534

Shoating Date/Time FALRAOD W0
T[ Shutter Speed | 14500
A Aperture Value | 56

IS0 Speed 100

Image Size 38B8.2592
Flash Off
Parameters Settings

File Size 7073KB
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Changing the Size and Type of an Image and Saving

Specify the image size, type, file name and save
destination, and then click the [Finish] button.

You can change the size of an image or convert it to a TIFF image

(extension “.TIFF") or a bitmap image (extension “.BMP”) and save it.

Because the image is saved as a separate image, the original image
remains unaffected.

1 Select an image.

2 Click the buttons [Export] P [Export Still Images].
‘Iﬁ E sport

|| Export Still Images

‘ Export Shooting Properties

‘ Ewport az & Screen Saver

‘ Ewport as & wallpaper

‘ Backup ta CD

=»The [Export Still Images] window appears.

image Sofings Yo can raccs the amaun of
— i mRmGey o fikas 1= by
EllBascs iveget dueg o900 rasiring he images 10 & smallar
sz
R = s r
¥ ..
ot F )
d G = B . .
&epariad phaos e I '] i
abacing tha origineis Laa W
[ 5 Reunmsnens | (] Change image bpe When Expiorting images as
. . Hiah JPEGE, you can also educe fle
1l sites by using o krwer Qunliy
#8ting which compresaes the
Cuiginal Fie Sire: B3MB - immge more. The mages wan't
: [ 1 Iexak s shis Lok s Wl iz
Madified File Size: KB Calculste il b ealar

FilaHama Sellngs

abC L Add mpratic |11

Epva o Fakdee

o) O Cumem Fodor
| @ MyPickess
O Spealy Folder Brorwse.
CADoeumerrs i ini

et Eorw: | ‘

=» The image is saved as an image separate from the original
image.
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Exporting Shooting Information .
Introduction
You can export as a text file the shooting information recorded to the Specify the export shooting information and save
Image. destination, and then click the [Finish] button.
: - Table of
1 Select an image. Contents
Expor Settings Shooting properties are stored
2 Click the buttons [Export] B [Export Shooting T G PE
Properties]. _ il v LR Operation
‘@ E=part :T.;“raw:?:mm:!r
i ?E:?‘-E%:‘E{E‘?nﬁ LA Cinsl Paneue Comoensstion Y. Advanced
Export il Images e Operation
Exrrrr— (.
Export Shooting Properties {57 Speckytie name and tolder
EJ | CAD: and Sasinge\ad \2 ingFrop w |

Export &z a Screen Saver NOTE: Propemes wi be soved as 1841 ") fles.

Export az & wallpaper

Backup to CD Preferences
=» The [Export Shooting Properties] window appears.
L . . . Reference
=» The shooting information is saved as a text file (extension
“TXT").
Contents
Lookup
Index
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Organizing Images Using High-Level Functions

You can organize images using high-level functions such as setting
keywords and entering comments, renaming multiple files in a single
operation and classifying images by shot year/month/date, all of which
are useful when organizing your images.

Setting Keywords in Images

You can set keywords to identify images. The set keywords are also
useful when searching for images (p.52).

Display the [Properties] window (p.46).

Click the [[¥]] button in [Keywords] and then click

the [View/Modify Keywords].
The [View/Modify Keywords] dialog box appears.

&7 View/Modify Keywords %'

Check or uncheck the boxes to change the way Keywords are applied to the selected files. To add a new Kepword, type the name in the
text field below the desired category, and press the + button.

Peaple: Places: Events: Others:
[ Children [ Beach [ Birthday [
] Farnily [ City [ Haliday
[ Friends [ Hame [ Party

| | | AV
Select the star rating to assign to the selected files

Pt Sy Feset

I'[ Ok ]‘I[ Cancel

The keyword is set in the image.

Select the keyword(s) and then click the [OK] button.

Entering Comments into Images

You can enter information relating to images as comments. The entered
comments are also useful when searching for images (p.52).

Display the [Properties] window (p.46).

Click the [|_¥ |] button in [Comment].
A field for entering comments is displayed.

Enter text and then press the < Enter > key on the
keyboard.

51" Properties E|
HModified: pitet e o
File Size: E.9ME
. Image Size: 3888 = 2532
Drata Type: APG

Sound:

Path: C:ADocuments and SettingshAdministratarikdy

File Mame:

@G_num

Star R ating:

[P
L Lt

Comment;

i

Fepwords:

[ Erightness Histogram:

Lk

[

[&] Shoating Information:

Iterm Mame Walue e
Fils Mame IMG_0001.JPG
Camera Model Canon E0S5 e

Shooting Date/Time 00000000 2o
Tl Shutter Speed ] 1/500
Ayl Aperture Value ] BB

150 Speed 100
Image Size 3888.2592
Flash off

Parameters Settings ~

The entered text is saved in the image.
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Introduction
o _ _ _ and then click the [Finish] button.
You can copy multiple images and save them with new file names in a
; ; ki Table of
single operation. Contents
Select all the images you want to save with new file il TS s S
names (p.11). EE,J il —~ Basic
: © Niw Name = Shootng Date + Nunbis ‘?E"G ‘5:‘“'3 Operatlon
. . - tldwhl)m task o rename a group ) Shooting Date + New Name + Number
2 C|IC|$ the puttons [View & Classify] P> [Rename — ) B
Multiple Files]. o n e o Y[l mm e
T Mumber of g g ?,E?::‘:im”;‘.;x;ﬁi« Advanced
‘ Wiew a3 a Slide Show ‘ 2t
MNOTE: The onginal data bype [xx) will be retained,
Rename Multiple Files
Clazzify into Folder
‘ Search ‘ | Preferences
-» The [Rename Multiple Files] window appears.
C . Reference
=» Images separate from the original images are saved with the new
names.
Contents
Lookup
Index
@ In step 3, if you remove the check mark from [Make copies of files] @

in the window, please be aware that the file name for all the selected

images including the original images changes. 50



Classifying Images by Shot Date

Multiple images can be classified into different folders according to shot
date.

1 Select all the images to be classified (p.11).

2 Click the buttons [View & Classify] P [Classify into
Folder].

‘ m Wiew & Clazzify

Wiew az a Slide Show

Rename Multiple Files

Clazzify into Folder

Search

=» The [Classify into Folder] window appears.

Specify the folder structure and save destination,
and then click the [Finish] button.

‘When classitang by shooang
date. ZoomBErowser EXwill onby
classity photos with shooting

" Specity folder structure:
FJ data infarmation and skip ovar

YeaMonthData -

I - p; jphatos without shoating date
“" Exampla Folder Structra: information.
i = CAD: and Satings\Admi iy Dacurmer
Use this tazk i organize your . W By defoull, ZoomBrowser EX
phatos into new folders bazed on copus the ongnal pholos o the
shooting date. nivw foldrs. To Save space on

Wiaur computar. chooge 1o mave
tha photos instend.

(5 Armiotisnies |

Y ’. & Cumaet Folder
- h © MyPictures
O Specity Folder __HMB.

Copry or Mo ImBgRs

o == @ Gopy
O Move

=» Images are classified by shot date.

Settings for Folder Structure

Setting Item
YearMonthDate

Description

Classifies images by creating a first-level folder
according to shot year/month/date.

Year\YearMonthDate Classifies images by creating a second-level folder
for the shot year, and the month and date.
Classifies images by creating a third-level folder
for the shot year, the month, and the date.

Year\Month\
YearMonthDate

G

Introduction

Table of
Contents

Basic
Operation

Advanced
Operation

)

Preferences

)

Reference

Contents
Lookup

Index

51



Searching for Images

You can search for images by ratings (p.21), shot date, update,
comments (p.49) and keywords (p.49).

Click the buttons [View & Classify] P [Search].

‘ @ Wiew & Clagszify ‘

‘ Yiew a3 a Slide Show ‘

‘ Rename Multiple Files ‘

| Clazzify inta Falder |

II Search |I

The [Search] window appears.

Specify the search criteria and then click the [Next]
button.

BT ZoceBrowser EX - C:\Documents and Settings\idminksirator\ty Decuments\My Plclures EER

Fie Edb Vew Took [dered Heb

& Match all condions 2 Meatch amy condition
E [ Ster Roting

Find images with tha salecied star rming

& [ Modsication Dots

Fi basad 3 thay

T —

[&] [ Shactng Date

E O Comment

that hene comements

& [ Keywoeds

Sesdnctad B 1

The search begins and the images that match the criteria are dlsplayed

Click the [Finish] button to close the search results

window.
The display returns to the main window.

Check the searched images in the main window.
The searched images are displayed as [Search Results] in the
folder area in the main window. If you select this folder, the
searched images are displayed.

Tasks e o] e how [P earh
: ™~

8] Acquie & Comns Setings Zoom Moot | Gt Mods | Privrems Miske

:m Views Clossdy I Saarch Fieauls Q H-0-|n|x Jmn | e -
L .

L e

- Export '

&l Pt ina

Lﬁ EANON MAGE GATEWSY I -
i - Xt : J .

m_um_m MGO002 PG IMGONEPG MG OIMIPG  IMGONSFG  IMGO06FG

T ING_IIII?_'PG MG 0002 PG IMGOO09.FG  IMG O0I0PG MG 0011 PG IMG_0012.FG

IC1¢] |_>nuu; || |
EE | w -z
12 My P
5 8 oy Prtunss .
ey s

IMG 0013 PG MG O0I4PG  IMG_O0IS. PG IMG_O016.PG

The images inside the [Search Results] folder are stored until
you either perform another search or exit ZB.

Any work you do on images inside the [Search Results] folder will
be applied to all the original images. Therefore, please be aware
that if you edit or delete images inside the [Search Results]
folders, the original images will be edited or deleted also.

@ You can click the [ |2

b ] button in the main window and display
the [Search] window.

G
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Performing Advanced Editing

This section explains image editing using high-level functions based on Adjust the image.
the assumption that you are familiar with handling standard image
editing software. Table of

IPEG images deteriorate slihtly when eclted and saved. and the image T ——— | oo

Introduction

Drag to the left or right to adjust

before editing cannot be recovered. For this reason, an edited JPEG o R
image should be saved as a separate image from the original image. |
&l You can edit RAW images in Digital Photo Professional (hereinafter, | — OpBe?Zic(i:on
“DPP"). Select the RAW image in the Main Window and click the fie J |D—_f'
buttons [Edit] » [Digital Photo Professional Process RAW images], o J |4:
which will start up DPP. For detailed instructions on using DPP, Bl J L & Advanced
refer to “Digital Photo Professional Instruction Manual” (PDF Operation
electronic manual).
Hig%vel
Adjusting the Color of an Image in RGB Fungons
You can adjust the color of an image in RGB (red, green, blue).
. . . . Preferences
Select an image and display the [Edit Image] window
(p.29). . W
Select [Color/Brightness Adjustment] and then click e Reference
the [Finish] button. -» The image is adjusted.
The [Color/Brightness Adjustment] window appears. £ Click the [Save As] button and save as a separate
From the list box, select [RGB Adjustment]. image (p.30). ‘ioofglfﬂés
iWidministratony DocumentsiM. .. |Z|E| E|
Please select adjustment option:
Color Adjustment A4 Index

RGE Adustment
o | [CEverAaustment
Tone Curve Adjustrment

Saturation: j — f: @ @
- ]

Contrast: j o |
The window switches to the [RGB Adjustment] window. @‘




)

Drag to the left or right to adjust
The image is adjusted.

Click the [Save As] button and save as a separate
image (p.30).

Introduction
Adjusting the Brightness Level Adjusting the Tone Curve
You can adjust the level of brightness (balance). You can adjust the brightness, contrast and color of a specific area by Table of
: : : : changing the tone curve. antgnots
Select an image and display the [Edit Image] window
(p.29). Select an image and display the [Edit Image] window
. . . (p-29). Basic
Select [Color/Brightness Adjustment] and then click Operation
the [Finish] button. Select [Color/Brightness Adjustment] and then click
The [Color/Brightness Adjustment] window appears. the [Finish] button.
. . The [Color/Brightness Adjustment] window appears. Aol
From the list box (p.53), select [Level Adjustment]. _ Operation
The window switches to the [Level Adjustment] window. From the list box (p.53), select [Tone Curve
, : Adjustment]. :
. Highg |
Adjust the image _ -» The window switches to the [Tone Curve Adjustment] window. Fll?rB?\r/]i
[=] Color/Brightness Adjustment - C:¥Documents and Settings i dministrato vy Documentsiby Picturesboooe soc... |._|®
(e —— ——
. i’ Preferences
Channel @l
!; Input Levels: EI IEEL_I
Reference
Contents
Lookup
1 Show Driginal Image|
i - Index
[oache ] -
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Adjust the image.

[=] Color/Brightness Adjustment - C:\Documents and SettingskhdministratoriMy Documentsiiy Picturesioooot ... |Z||E‘E‘

Pleasze select adjustment option:

| Tone Curve Adjustment - |

-~
e 4 Channel:

_______________________________

] Show Original Imags)

Unsharpening an Image

You can set amount, radius and threshold values and adjust sharpness.

T |

Click to add a [ H ] (point)
Adjust by dragging [l ]

The image is adjusted.

The horizontal axis shows the input level and the vertical axis
shows the output level.

The maximum number of [l ] is 10.

To delete a [ M ], either press the < Del > key on the keyboard or
double-click on the [l ]

Click the [Save As] button and save as a separate
image (p.30).

Select an image and display the [Edit Image] window
(p.29).

Select [Sharpness] and then click the [Finish] button.

The [Sharpness] window appears.

Select the [Unsharp Mask] tab sheet and adjust.

[=] Sharpness - C:\Documents and Settings\idministratoriy DocumentsiMy Picturesboooc soc 01MMG_0015.JPG |Z|@

Unsharp Mask.

Sharpel

Amaurt j —— *
Radiug| s — pineks
Threshold ]' 0 2 levels
ot

)
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Drag right to adjust
The image is adjusted.

Enlarge the window and check the adjustments
(p.30).

Click the [Save As] button and save as a separate
image (p.30).
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Introduction
Transferring Images to Other Image Editing Software Merging Images to Create Panorama Images
You can transfer images to image editing software other than ZB. You can merge up to four JPEG images to create panorama images. Table of
For merging images, start up the image-merging software “PhotoStitch” antgnots
Select an image and display the [Edit Image] window from ZB and use.
.29). . .
(p-29) Select multiple images to merge (p.11). Basic
Select [Edit with external image editor]. Operation
Click the buttons [Edit] P> [Stitch Photos].
Click the [Manage List] button and then register the Advanced
. ey -4 Edit -
image editing software. Operation
Select the image editing software in the window that appears. ‘ Ecit Juaelf
In the [Edit with external image editor] list box, select r o Hig}ivel
the registered image editing software. TS —— Fungions
{[nfle=] b0 FToMeEE10na
Click the [Finish] button. Al
The software selected in step 4 starts up and the image selected *» PhotoStitch starts up and the main window appears. Preferences
in step 1 is displayed.
Reference
Contents
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Check the arrangement of the images to be merged

and click the [2. Merge] tab sheet.
@ If the arrangement of the images to be merged is not correct,
drag the images to rearrange them.

£! PhotoStitch EEX
File Edit View Merge Help

Merge Images Shot in Stitch Assist Mode
Click [2. Merge] to merge these images.
Far images shot as a 360-degree panorama, click [Arange].
select [360 Degrees] and then click [2. Merge].

4

Open.

STITCHOT.JPG STITCHOZ.JPG STITCHOZ.JPG STITCHO4.JPG

Mo, of Images: 4 | |1024x768 True Color

=» The window switches to the [2. Merge] tab sheet.

N

4 Click [Start] to merge.

& PhotaStitch
File Edit view Merge Help

Merge Images
Click. [Start] tao begin merging.

‘ o) )

Enlarge Reduce

STITCHO.JPG STITCHOZ.JPG STITCHOZ.JPG STITCHO4.JPG

Mo, of Images: ¢ IPanmng (Scenery, ete,) iFocaI Length | Auto Acguire - Canon M

|

=» The images are merged and displayed.

Click the [3. Save] tab sheet.
=»The display switches to the [3. Save] tab sheet.

G
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Check the save range and then click [Save].

& PhotoStitch
File Edit Yiew Merge Help

Save Image
Click [Save] ta zave the merged image.

To merge a different image. returm to [1. Selection and Arangement].
click [Clear] and then [Clear A1)

Image Size | 2667739

Save range
Drag [ ¥ ] to change the range

The [Save As] dialog box appears.

Specify the save destination and then click the
[Save] button.
The merged images are saved.

Select the [File] menu P [Exit].
PhotoStitch exits.

|§| See also the Help that are displayed when you click[ ] on the
right of the window for information on operating PhotoStitch and
PhotoStitch functions.

Adding Sound to Images/Playing Back

You can add sound to images and play back sound which you have
added to images with a camera that has a sound record function.

Adding Sound to Images

You can add WAVE sound files to images (extension “.WAV”).

Select an image to which you want to add sound.

Select the [Edit] menu P [Add/Remove Sound].
The [Sound] dialog box appears.

Click the [Add] button and select the sound file to be

added to the image.
© Select a WAVE sound file.
=» The display returns to the [Sound] dialog box.

4 Click the [OK] button to close the dialog box.

= The [] icon is displayed on images to which sound has been

added.

Playing Back Sound

You can play back sound files that are attached to images.

)
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Select an image to which a [ [/f]] icon is attached.

Select the [Edit] menu » [Play Sound].
The sound is played back.
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Printing Using Other Printing Software

You can start up printing software installed on your computer from within
ZB and print images.

Select an image you want to print.

Click the buttons [Print] P> [Print Using Other

Software].
The [Print Using Other Software] window appeatrs.

Select the printing software and then click the
[Launch] button.
The printing software starts up and the image you selected in
step 1 is displayed.
Make the necessary settings in the printing software
and print.

? Printing software does not appear

Printing software that is incompatible with ZB does not appear in the
[Print Using Other Software] window and can therefore not be used to
print.
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4 Preferences
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Preferences

You can change any of the ZB functions in the preferences window.
Check the settings displayed for each window before making changes.

Introduction

General Settings

You can make settings such as adjusting the minimum size of thumbnail
Select the [Tools] menu P [Preferences]. images that are displayed in the main window, the speed of Zoom Mode (-:rgr?':gnotfs
(p.68), the levels of image and folder display in Scroll Mode (p.69) and
color management.

Select the tab sheet to be set, make changes to the

. . Basic
settings and then click the [OK] button. ; - Operation
_ = Preferences E_d
&1 Preferences §|
e Frinting Shoating Infarmatian Themes
Printing Shoating Infarmatian Themes ' General |_ Selection . Rotation édvant(.:ed
General | Selection R otation . . R i
: . Thumbnail;
Thurnbnail: - Minimum vizible thumbnail size: E - : pivels
o = - — |- = — High-Level
Minirurn visible thurnbinail size: E £ pisels | Miriirnm click able thurmbmail size: I3 2| pinels Fugnctions
kdinimurm clickable thumbnal size: |B = | pinels - ..
L Zooming;
Zooming:;

Smooth — — J Fast
Srmooth J Fast ! Prefgf@nces

Color Management:

Lty bl eloleu [ Adjust color of images using monitor profile
[ Adjust color of images using monitor profile _d Reference
i - | Mauimum scroll made folder depth: D 2| levels
b aximurn scroll mode folder depth: 0 =2 levels } .
) . “Warn me when hiding files using the Filter Toal Contents
Warh me when hiding files uging the Filker T ool Lookup
Index

00

= H — - O, H Cancel @
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Introduction
Selection Settings Rotation Settings
You can make settings related to image selection. You can make settings related to image rotation. Table of
Contents
=1 Preferences rg| &1 Preferences ['5__<|
Printing ~ Shooting Information Themes Printing Shooting Information | Themes | Basi(_:
General | Selection | R otation [ General Selection | Rotation Operation
Selection Type: YWwhen rotated JPEG images are downloaded from the camera:
() windows standard zelection [CI{Rotate onginal image 'deant(.;ed
............................................... : i
() Toggle selection . i . i
JPEG images rotated on the camera store rotation infarmation
with Shoating Information rather than ratating the actual image.
Tazk Selection: ;
IF this box 1z checked, the actual image will be rotated when it iz H'gh'l-,evel
[ &lways select images inside a task dovenloaded bo pour computer, Functions

Howeser, for images with Original Decizion D ata, the actual
image will not be rotated.

: = e _ Prefgf@nces
Frompt me after playing movies with rotation information
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Printing Settings

If you are printing with the [Photo Print] window (p.15), you can set
whether to trim the image and print with no borders around the paper, or

to print as is without trimming.

Shooting Information Settings

You can set the information that is displayed when you click [ =& ]
(shooting information display) in the viewer window (p.71).

&1 Preferences

Gereral | . Selection . _ Ratation
Frinting | Shooting |nfarmation Themes

Trim Setting [for Photo Print T azk)

(%) Scale and trim image ta fit printable area

Scale [whilst maintaining azpect ratio] until the entire
printable area iz filled with pour image. Any excess image
will be trimmed.

(7 Do ot allow rimming of the image

Always show all of the original image.

MOTE: If thiz option is selected, the Trim feature in Step 2
of the Phato Print tazk will be dizabled.

Print tazks must be restarted before thiz setting will take effect.

(]S ] [ Cancel

& Preferences

General {| . Selection - Hutatiu:un

The zelected itemnz will be showr in the Viewer:

| Frinting Shooting Information Themes |

[ ] Carmera kadel

[ | Shoating Date,/Time
Shonting Made

[ ] Phota Effect Mode

[v] T Shutter Speed )

[v] Al Aperture Value )

[ tetering Mode
Exposure Compensation
[] Digital Exposure Compensation
[ Autoexposure Bracketing
IS0 Speed

[150 Speed Bracketing

[ ]Lens

L e I e

LS

w

)
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Fant: |.-i'-.rial v| Size: |14
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Showing/Hiding Task Buttons |
Introduction
: You can show or hide task buttons displayed on the left of the main
Themes Sett ngs window according to your requirements. Hiding buttons you do not use
You can set the background color for the main window. makes operating ZB easier. Table of
] Contents
= Select the [Tools] menu P [Customize].
= Preferences . ]
. - ; The [Customize] dialog box appears.
Gereisl | Sekcon | Rolaon | R the check mark from the butt t E
Prrting | Shooting Information  [f  Themes = empve € check mark ifrom the butlons you wan Gzt
to hide.
Select a theme below ta change the color scheme used in the
BiEwieE Ak an At ey Click the [OK] button to apply your changes. Advanced
Therme: Operation
iedumiog el . Restart ZB for the settings to be applied.
Prewview: .
i : . i High-Level
[ _ = Functions
pe— e
| '_1 R e P CREE T 3y E——
MR e KR O =1 Pre41ces
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Troubleshooting

If ZB is not operating correctly, refer to the items below.
Also refer to the Help from the [Help] menu or click the [?] button at the
top of each window and refer to the Help displayed.

Installation could not be completed correctly

You cannot install the software if a user setting with privileges other
than [Computer administrator] or [Administrator] is selected. Select a
user setting with [Computer administrator] privileges in Windows XP
or [Administrator] privileges in Windows Vista. For detailed
information on selecting the user setting, refer to your computer
User’s Manual.

ZB does not work

ZB does not operate correctly on a computer if its system
requirements does not meet. Use ZB on a computer with compatible
system requirements (p.67).

Even if your computer has the RAM capacity (memory) described in
the system requirements (p.67), if other applications are running at
the same time as ZB, you may not have sufficient RAM (memory).
Exit any applications other than ZB.

Images do not display properly

Images that are not supported by ZB (p.67) do not display. There are
various types of JPEG and TIFF images, so JPEG images other than
Exif 2.2 and 2.21 compatible images and TIFF images other than Exif
compatible images may not display properly.

With initial settings, the color of images that have been shot in Adobe
RGB appear weak. In this case, check the [General] tab sheet in
preferences and checkmark [Adjust color of images using monitor
profile] (p.61). Color management is performed and the color of the
image shot with an Adobe RGB setting and the image shot with an
SRGB setting are matched.

Deleting the Software (Uninstalling)

Exit any applications before uninstalling the software.

Log in under the Computer administrator/Administrator privileges
when uninstalling the software.

To prevent computer malfunctions, always restart your computer after
you have uninstalled the software. Re-installing the software without
first restarting your computer is particularly likely to result in computer
malfunctions.

Select the [Start] button ([ €] button in Windows
Vista) B> [All Programs] B> [Canon Utilities]
[ZoomBrowser EX] > [ZoomBrowser EX Uninstall].

Proceed with the uninstallation as directed by the

on-screen messages.
The software is uninstalled.
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System Requirements

0S Windows Vista*!

Windows XP Professional/Home Edition*2

PC with one of the above OS preinstalled (Upgraded
Computer | machines not supported)

* NET Flamework 2.0 or later is required.*3
L Windows Vista 1.3GHz Pentium or higher

Windows XP 500MHz Pentium or higher
S Windows Vista Minimum 512MB

Windows XP Minimum 256MB
Displa Screen resolution: 1024 x 768 pixels or more

play Color quality: Medium (16 bit) or more

*1 Compatible with 32-bit/64-bit systems for all versions except Starter
Edition (Also compatible with Service Pack 1)
*2 Compatible with Service Pack 2/Service Pack 3

*3  NET Flamework is Microsoft software. It is installed together with ZB.

Supported Images

Image type Extension
JPEG images shot with a Canon digital
JPEG images | camera (Exif 2.2 or 2.21-compatible JPG, .JPEG
JPEG images)
RAW images shot with a EOS DIGITAL .CR2
RAW images | camera excluding EOS D6000, EOS .TIF
D2000, EOS DCS1, EOS DCS3 .CRW
TIFF images | Exif-compatible TIFF images TIF, . TIFF
BMP images | Bitmap images .BMP
PCD images | Photo CD images .PCD

About RAW Image Task

RAW Image Task is the RAW image editing software linked with ZB.
RAW Image Task is not provided with ZB ver. 6.2, but if it is installed
on your computer, it can be started up from ZB ver. 6.2 in the same

way as from versions 6.1 and earlier.

RAW Image Task is not compatible with RAW images shot using an
EOS 50D.
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List of Main Window Functions

Zoom Mode
Slide show (p.36)

Properties window (p.46)

Viewer window (p.71)

51" ZoomBrowser, EX - C:iDocuments and)Se lmgs\.ﬂdnnmsllalur\My Docun

Folder path
File Edit Wiew Tools Internet Help

Shows/hides = Py
the task buttons =

[ Acquire & Camera Settings

e | Wiew Inage Propertles '_ SlldeShow

Image search (p.52)

Deletes images (p.26)

Rotates an image

Search 7

Delete ||~ W) Rotate

Moves the enlargement display position (p.13)
Full view (p.13)

Task buttons*! —

w01

| ::_’: Export

Iﬁj Print & Email

if.ﬂli CAMDM iMAGE GATEW&Y

-
Last Acquired Images 6

= =) AII Images
Shooting Date 'l
E o _wx_01
E s _wx_02
E o w03
El s _xx_04

| Favorte Folders.| All Folders

= a Deskkap

=53 My Documents
@ My Music
B My Pictures
100 weooe_oe 01
15w _02
1) oo o 03
100 oo _o_D4
[# i My Camputer
3 Search Results

Folder area*?

LB IME_oooac

mh . mgggf

wE_oono.cie

@ @ ﬁwﬁﬁv
N N e - A

IMG_00010RL [ ONZCR IWG_0001CRL IWE_00M4CRL IMG_00D5.CRE

m| Seroll Mods | | Preview Mode ’— |
l Djﬂ View & Classily My Pictures Q Q R-0-| k% [ | §F Filer -
sz Edit -

Selected Items: 1

Shows/hides the task buttons and folder area
Protect icon

RAW image icon

Audio recording icon

Number of selected images

*1 The [CANON iIMAGE GATEWAY] button may not be displayed depending on the area you are in.
*2 Images in folders and folders selected here are displayed on the image display area.

Display magnification (p.13)
Filter display (p.22)

Reduction display (p.13)
Enlargement display (p.13)
Cancels ['*_ ], ['=,]or[
Shows/hides the image or
folder information

Selects/deselects all the
images or folders

Displays the folder one level
above

Returns to the display of the
folder before [ (3 ] is clicked

Returns to the display of the
folder previously displayed

Image display area

Bracketing icon

]
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Scroll Mode Image search (p.52) Deletes images (p.26)

Slide show (p.36)
Properties window (p.46)

Rotates an image

Viewer window (p.71)

Folder path
. File Edit “iew Tools Internet Help
Shows/hides

. PN ! ] ! L & : i’”L . . .
the task buttons Task: Q I;IV'EW Image Propemas @Shde Shaw QSaarch @ Delete @Rotate Dlsplay magn|f|cat|0n (p13)
[Eﬂ Acquire & Camera Settings |WM|
[ m View & Classify ] Phato 9 | ‘P qi 5 ? y 4;]“ ﬁ Filter Fl|tel' dISp|ay (p22)
| e [ | [ SR | Shows/hides the image or
Task buttons*. [@ e | folder information
[ Print & Emal ] Selects/deselects all the
[@ CANDN iMAGE GATEWAY ] images or folders
st Q| [P Displays the folder one level
...... o ST, 5 above
Images acquired from your camera -
B s Returns to the display of the
folder before [ (3} ] is clicked

Returns to the display of the
folder previously displayed

Favorite Folders | Al Folders
E{a Desktop

=-{C) My Documents
My Music
=) My Pictures
== i Iy Computer
=3 Photo
BT soo_1000
-3 soo:_2000
[T wxx_3000
-3 Search Results

Folder area*?

Image display area

[ Add to Favorites ]

| Selected Items: 1 [ |

Shows/hides the task buttons and folder area Number of selected images

*1 The [CANON iMAGE GATEWAY] button may not be displayed depending on the area you are in.
*2 Images in folders and folders selected here are displayed on the image display area.
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Preview Mode

Folder path

Viewer window (p.71)

1 ZoomBrowser EX - C:\Documents and Seftings\idministratoriy Docun{

File Edit Yiew Tools [nternst Help

Shows/hides

the task buttons

Task buttons*! —t

Folder area*?

Tazks

| L@ Acquire & Camera Settings

Image display area Image search (p.52)

Slide show (p.36)

|
;l Slidz|

| Zoom Mode | Serall MDdel Preview Mode |

.‘ Yiew Inage

Deletes images (p.26)
Rotates an image

=

Show Lﬂ&Search p:j Delete @Rotate

| m Wiew & Classify
| 2{ Edit
| ?j Print & Email

| (; CANON IMAGE GATEWAY

| Export

P
Last Acquired Images 6

| Favorite Folders | Al Folders
= E Deskhop
=

E] My Documents

_ . @ My Music

=] Iy Pictures

H (£ s e 0L
£ oo 02
{05 wwx _xx 03

H (0 ww e 04

- i My Camputer

[-{ ) Photo

3 Search Results

Add to Favorites

w01

Q Q R-O-

ﬁg Filter -

III

File: Imfarmatifi:

File Mame: |I_ G_ 000!

A

M odilied: foetietoed [ Protect
File Size: 8. MB
| |Imagg: Sizel 3688 #2532

| |Data|Type. JPE
S ourid

Star [Rating:
v
S

Cornmnent:

A
Kepwords:

Brightress Histogram:

Shaoting Infarmation:

Item Name Walue
IMG_N008.IPG
Camera Model N...  Canon EDS 3604
Shooting DatedT... 2eAhecds
Tw [Shutter Speed] 141250

A [Bperture Val. 8.0

150 Speed 100

3888x2592

File Mame

Image Size

IMG_0001.JPG  IMG_0002. PG

1MG_0003. PG

IMG_0004,JPG  IMG_0005.0PG  IMG_0006.0PG  IMG_0007.IPG

<

Selected Tkems: 1

Shows/hides the task buttons and folder area

Switches between images

Filter display (p.22)

Shows/hides the image or
folder information

Selects/deselects all the
images or folders

Displays the folder one level
above

Returns to the display of the
folder before [ (3} ] is clicked

Returns to the display of the
folder previously displayed

Information display area

Shooting information (p.46)

Thumbnail image display
area*>

Number of selected images

Shows/hides the information display area

*1 The [CANON iMAGE GATEWAY] button may not be displayed depending on the area you are in.
*2 Images in folders and folders selected here are displayed on the thumbnail image display area.
*3 Images selected here are displayed on the image display area.
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List of Viewer Window Functions

Photo print window (p.72) Edits (p.29 to p.35, p.53 to p.56)
Moves the enlargement display position (p.21) Shows/hides the AF point

Reduction display (p.21)

Enlargement display (p.21)
Folder path

File Edit Wiew | Help

@ R QD

Switches between
images

Split displays (p.44)

[ ZoomBrowse ;tratur\My Documents: Pu'.y Picturesboooc o 01VMG_0001, JPG

Shows/hides the shooting information (p.14, p.20)

FEX

Fit-to-window view
(p.21)

100% (actual pixel
size) view

Display magnification——]
(p.21)

Full view display (p.14) —
Rating (p.21)

Zoom Ratio: 22%

Synchronize (p.44)
File name

)
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List of Photo Print Window Functions

Printer selection and —

settings

Trim

s the image

57 ZoomBrowser EX - C:\Documents and SettingsiAdministratoriMy DocumentsiMy Pitturesboooc oc 02

File Edit Wew Tools Internet Help

Printer and Layout Settings M

-
Select Images Printer

MName:

Fhoto Bettings and Preview

Femove unwanted
regions of your photo.

Trim Image Insert Text

Inserts text

Add or bodify text to
print with this phota.

|Cﬁn|:|n><><>< v‘

Media Type:
|Ph0t0 Faper Pro v ‘

page FPaper Size:
" )

v| Borderess

-
Shooting Date/Time

\_4_“ Photo: 141 Copies: |1 3

Mone Qj‘
Properties.
J
[ < Previou ][ Print ] Cancel ]

Total: 1 pages

— Print preview

Selected Ikems: 1

Shot date and
time printing

Borderless printing

Switches the printing image

Number of prints
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List of Index Print Window Functions

Paper orientation

Layout settings

Print information ———

settings

Printer selection and settings

#1 ZoomBrowser, EX - C:\Documents and SettingsWhdministratorisy Documentsiby Picturesioooo: soc 01

File Edit Wiew Tools Internet Help

. Select Imagez

Printer and Layout Settings

= :
Frinter Freview
MName:

‘Canon o v|

Rotate Left Rotate Right ‘ Ttim Image

Media Type:
‘ Phota Paper Pro b |

FPaper Size:

s v

\.

Orientation:

®Porrait O Landscape J

Copies: |1 5 7|‘

Total: 1 pages

rpage Layout Settings B
Columns: 3 | |
Fiows: 3 ¥

. >

-
Shooting Information

[ HeaderFooter

Coms ) |y
|

Seftings... | Q
. J/

Page: 1/1 Q

< Previous ][ Print ] [ Cancel

Selected Tkems: 9

Number of prints

Switches the printing page

Print preview
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Introduction
Contents Lookup
Table of
Downloading Images to Your Computer Image Editing Contents
Download images by connecting your camera Use automatic adjustment ->p.29
and computer 2p7 Adi : :
just brightness/darkness = p.31 Basic
Download images using a card reader - p.9 Make colors more vivid -p3l Gzt
Image Checking Réise the contra.st = p.31 .
Look through -p.i1 Trim parts of an image = p.32 Operation
+p13p20  hechyanashect o hat matches e wze o+ paz _
Check efficiently = p.23 Make an image sharp - p.34 HFE’r?c-tLig\rlgl
Compare multiple images = p.44 o Insert text - .33
(Cj::ttzck the shooting information such as shot - p.46 o Correct red-eye - .35 A
View as a slide show -» p:36 N = p-56
Image Printing Utilizing Images Reference
Print one image on one page - p.15 ® Attach an image to an e-mail -> p.37
Print using Easy-PhotoPrint EX - p.16 @Make into computer wallpaper = p38
Arrange multiple images on one page and print = p.42 Make into a computer screen saver =p39
Organizing Images Converting Images
Sort by rating »>p21 Change the size - p.47
Move to a different location -»p.25 Convert to a different type = p47
Move by entire folder to a different location = p.25
Change the file name - p.26 @ @
Delete = p.26 @
Classify by shot date = p.51
Search = p.52
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Index
A
Adding SoUNd 10 IMAGES.........uuiiiiiiieiiiii e 58
AdJUSt JPEG IMAQGES....uuuuiuuriiuiiiiiiiiiiiiiriirsrrerinesrrerrsrreeesreer. 29, 53
Adjusting (JPEG or TIFF IMage)..........uuueeueemimeeiieiiieiieieeeeeeeeeeeeeeee 29, 53
AdiuStiNg IN RGB ... 53
Adjusting the Brightness.............cccco oo, 31
Adjusting the Brightness Level .........cccccoovieiiiiiiieen, 54
Adjusting the Contrast ... 31
Adjusting the Saturation ..............cccooo 31
Adjusting the Sharpness ... 34
Adjusting the Tone CUrve..........ooooei s 54
Automatic Adjustment ... 29
CorreCting REA-EYE .....oii e 35
Unsharpening Mask ... 55
Adjusting the Brightness ... 31
Adjusting the Brightness LeVel.............uuuviiiiiiiiiiiiiiiiieeiieeiieeeeeeeeeeveeeee 54
Adjusting the CONLrast..............uuuuuueimiiiiiiiiiiiiiieieeeieeeeeeeeeeeee e 31
Adjusting the Saturation.................eueueiiiiiiiiiiiee e 31
Adjusting the SharpnesS....... ... eeeaia e 34
Adjusting the TONE CUIVE .........uuiiuiiiiiiiiiiiiiiiiiiiievieeveerveeevessseessessssssaes 54
Attach an Image to an E-mail...........cccoooiiiiiiiiiiiee e 37
Automatic AdJUSIMENT........oooiiiiii e e e 29
B
Batch Change the File Name of IMages.......ccccccovviiiiiiiiiiiiiiiiiiieenn 50
C
Change File Name ..., 26
Change Folder Name...........ccccovviiiiiiii 26
Change the Display Magnification ............cccccco 13
Changing the Folder Level Settings........cccccooeeeiei, 45
Changing the Size and Type of an Image and Saving....................... 47
Checking the Shooting Information...................cccc, 46
Classifying the Images by Shot Date ..., 51
Color ManagemenNt ...........covviviiiiiiiicee 61
Compare Multiple IMages .......cooeeviieiiieeee e 44
CONIIAST .o, 31
CorreCting REA-EYE......cuiiiiiie e 35

Creating a Folder...........cooooi i 24
D
Delete
Delete FOlders. ... 27
Delete IMAGES .....eeiiiieeiiie e 26
Delete the Software ... 66
Delete FOIEIS ..covviiii e e 27
Delete IMAGES ....vvveii i e e 26
Delete the Software (Uninstalling) ............ccccuvviiieiiiiiiiiiiiieeee e 66
Deleting the ZB (Uninstalling) .........ccoovuiiiiiiiiieiieeeccin e, 66
Displaying Images Shot with Adobe RGB ...........ccccooiiiiiiiiiiiiinie 66
Downloading an Image to Your COMPULES .........ccceevvvviiinieeeeeeeeeiiinn. 7
Downloading Images from a Camera ..........cccuveeeeeeeiiiiiiiiieeeeeeeenns 7
Downloading Images from a Card Reader...................cccoeeeeeeee. 9
Downloading IMAJES ......cceieiiiiiiuiiiiiiiie et 7
Downloading Images from a Card Reader .................ueeeeeeveeeieeeeeeeennnnne. 9
E
o 11 1] o PR - Adjusting
ENlarge FOIAEIS .. eeeees 12
ENlarge IMages .......cooveeeiiiiieeiiis e e e e e e 13,21
EXITING ZB ... 18
Exporting Shooting INformation .............cccccuveiiiiiiiieeieiiieieeeeeeeeeeeeeeeeee 48
F
Favorite FOIAEIS. ... 27
FUIl VIEW DISPIAY ...t eeees 14
G
General Settings (Preferences) ......cocoooooeoiiiiie 61
I
INAEX PrINtING...cciiiiiiiieeie e 42
INSEIT TEXE. . e e e e e e eeeneaeas 33
INSErting COMMENTS .....coiiiiiiiiiiiee e 49
Inserting Text INtO IMAJES .......cevvviiiiiie e e eeeeaeens 33
K
NG Yo (0 SRS T= 1 1] T T PP 49
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L

Listing Images by Folder Level ... 45

M

MaIN WINAOW ...ooiiiiiiiiiiiiice et e e 7, 68

Merging Panorama IMagesS. ..........uuuuuuuuuruuueerieiieeeeeeeaeeeeeeeeeeeeeeeeeeeeeeeess 56

Move Or COPY FOIAEIS. ... ... 25

MoVve OF COPY IMAGES.....cooiiiiiiiie et 25

N

NP A2 T T (0T g1/ o [0 1SR 13,21

@)

Operating With EOS ULIlILY .....covviiiiiiiiiiiiieeee e 8

P

Playing Back SOUNG..........cooiiiiiiiiiiiceeee e 58

PrEfEIENCES. ...cii i 61
General SetliNgS. ... e 61
Printing SEttNGS .....evveiiiiiiiiiiiiee e 63
0]tz L0l g IS = 1 1] 0o [P 62
SeleCtion SEttiNGS......uuuuiiiiii e 62
Shooting Information Settings ......cccovveviiiiiiiiiii i e 63
ThemeS SEttiNgS .....occcvviiiiiieee e 64

Preview Mode (Main WindoW) ..........ccooiiiiiiiiiieeiiieieeeee e 23,70

Printing
INAEX PIINTING ...ttt 42
Printing an Image Using Easy-PhotoPrint EX ............cccccooiiinenee. 16
Printing One Image on One Sheet of Paper............................... 15
Printing with Printing Software other than EPP EX..................... 59

Printing an Image Using Easy-PhotoPrint EX.........cccccoovviiiiiiiiiiiennn. 16

Printing One Image on One Sheet of Paper.........ccccvvvvvveeiiiiiiiiennenn. 15

Printing Settings (Preferences) ......oovvvviiiiiiiieeveeeice e, 63

R

RATINGS ettt 21

ROtate IMAGES ... 68, 69, 70

Rotation Settings (PreferenCes)........uuuvvvrivriiiiiiiiiniieerieeerrrreereeeerenene. 62

S

Scroll Mode (Main WINAOW) ........oooiiiiiiiieeeeeiiiiiieee e 45, 69

Searching for IMages ... 52
Selection Settings (Preferences) .......oooooeoeeoiieiieci e 62
Setting @ SCrEEN SAVEL........ccoo e 39
Setting a Wallpaper ..o 38
Setting an Image as a SCreen SaVer.......cccoveeeieeiieeeeeececceee s 39
Setting an Image as Wallpaper ........ccooooiooiiiii e 38
Shooting Information Settings (Preferences).........ccoooeeeciieiiiicccicicnnns 63
SIMPIE DiISPIAY ..o 11
SHAE SNOW.....eiiiiiiiie e 36
Y= T[T R U] 174 = TS 7
SUPPOIEA IMAJES ... ..ttt 67
Synchronize DISPlay .......ccoeeiiiiiiiii 44
SyStemM REQUITEMENTS .......ovitiiiiiiiiiiiiieee et 67
T

Themes Settings (PreferenCes) .........uuvvvviieiiiiiiiiiiiieeeeee e 64
Thumbnail Display (Main Window) ...........ccccccviieiiiiiiii, 11
Transfer Images to other Image Editing Software ............cccccvveeeeennnne 56
LI 01 10T T P 32
TrMMING &N IMAGE.......oo i 32
U

UNSharpening MaSK..........coceuiiiiiiiiiiiieeee e 55
A

VIEWET WINOOW......uuueeiiiiiiiiiiiiiiiiiiiiiitieeeeeeseeeeeeeseeeeeesseesseeneennes 14,20, 71
W

WItiNG IMAageS t0 @ CD ....uvvviviiiiiiiiiiiiiiiieeiieeeieeeeeereeeseeeeeseseeereeeeeereneaee 41
WIEING 10 & CD ..ttt eeeeeeeeeeees 41
Z

Zoom Mode (Main Window) .........cccoovvviiiiiiii . 11, 68
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About This Instruction Manual

It is prohibited to reproduce, in whole or part, the contents of this
Instruction Manual without permission.

Canon may change without notice the software specifications and
contents of this Instruction Manual.

The software screens and displays printed in this Instruction Manual
may differ slightly from the actual software.

The content of this Instruction Manual has been reviewed thoroughly.
However, if you should notice any errors or omissions, please contact
a Canon Service Center.

Please note that irrespective of the above-mentioned, Canon does
not take responsibility for the outcome of the operation of the
software.

Trademark Acknowledgments
Microsoft and Windows are registered trademarks or trademarks of
Microsoft Corporation in the United States and/or other countries.
Other names and products not mentioned above may be registered
trademarks or trademarks of their respective companies.
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